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Introduction viii
Introduction

Welcome Welcome to the IBM® Sterling Gentran:Server® for UNIX electronic data 
interchange (EDI) and electronic commerce (EC) software. 

Who should use
this guide

This guide is for the following audiences:

◗ Administrators responsible for installing and configuring EDI or EC application 
software

◗ Users of the Sterling Gentran:Server product

Use this table to determine which chapters are for you. 

Reference
See the Chapter Content topic for a description of each chapter. 

If you are... Then refer to...

An administrator Chapter 1-3

Using Sterling Gentran:Server 
for the first time

Chapters 4-6

A user and you are upgrading 
from Sterling Gentran:Server 
5.4

Chapters 4-6

A user and you are upgrading 
from Sterling Gentran:Server 
5.3 or prior version

Chapters 4-6
Getting Started Guide – May 2011



Introduction  ix
Required skills This guide assumes that you are familiar with basic Windows concepts and 
commands, including:

◗ How to navigate and operate within the Windows environment
◗ How to use DOS commands and the DOS window within the Windows 

desktop

A knowledge of UNIX is also needed to successfully install and set up this 
product. IBM® Sterling Gentran:Server® for UNIX is a client/server product that 
allows EDI users to use Windows client computers to access programs and data 
on the UNIX host. This guide assumes you are familiar with basic UNIX concepts 
and commands, including:

◗ How UNIX identifies users and associates them into groups
◗ File ownership
◗ How to change the current directory
◗ How to set environment variables
◗ How to start and stop UNIX processes
◗ How to run UNIX scripts

Product
packaging

Your IBM® Sterling Gentran:Server® for UNIX package should include the 
following items:

◗ The Host software CD
◗ The Client software CD
◗ A CD containing the Sterling Gentran:Server EDI Standards
◗ A CD containing the Sterling Gentran:Server online documentation
◗ The IBM® Sterling Gentran:Server® for UNIX Getting Started Guide

Notes
If your company purchased IBM® Sterling Gentran:Server® Extension for SAP R/
3, then your package should also include:

◗ The Installation Card for Sterling Gentran:Server Extension
◗ The SAP Host software CD
◗ The SAP Client software CD

WARNING
If additional installation instructions came with your Sterling 
Gentran:Server shipment, those instructions take precedence over 
the instructions listed here.
Getting Started Guide – May 2011
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Sterling
Gentran:Server

products

This guide provides instructions for installing the following IBM® Sterling 
Gentran:Server® for UNIX products:

◗ IBM® Sterling Gentran:Server® for UNIX
◗ IBM® Sterling Gentran:Server® for UNIX with ADD

The title of the Installation Checklist included with your software indicates which 
product you purchased.

Sterling
Gentran:Server

utilities

Depending on which level of Sterling Gentran:Server your company purchased, 
the following utilities may be included:

◗ Communications Toolkit
◗ Life Cycle 

Communications Toolkit
The Communications Toolkit is included in the IBM® Sterling Gentran:Server® for 
UNIX. The toolkit scripts are automatically installed when you install IBM® Sterling 
Gentran:Server® for UNIX. If you want to use the Communications Toolkit, you 
must first install and configure Sterling Gentran:Server, then set up the toolkit.

Reference
See the Setting Up Communications chapter in this guide.

Life Cycle 
IBM® Sterling Gentran:Server® for UNIX - Process Control Manager include the 
Life Cycle data tracking utility. Life Cycle requires additional database software. 
Life Cycle must be set up on the UNIX host by someone familiar both with your 
site database and with UNIX. 

Reference
See the IBM® Sterling Gentran:Server® for UNIX - Process Control Manager 
Data Flow Administration Guide or the IBM for UNIX - EC Workbench Data Flow 
Administration Guide for detailed requirements and for instructions for setting up 
the Life Cycle tracking utility.
Getting Started Guide – May 2011
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Supported Configurations

Introduction This topic describes the hardware and software configurations supported by IBM® 
Sterling Gentran:Server® for UNIX. 

Windows client Each Windows client must have: 

◗ A CD-ROM drive
◗ Microsoft Windows XP® SP2
◗ Windows 7
◗ A minimum of 1GB of free disk space

Note
Your Windows operating system may require updates to work correctly. Check the 
following Microsoft web site to determine and download the latest service packs 
for your operating system:

http://www.microsoft.com/windows/downloads/default.asp

UNIX host The UNIX host computer must have:

◗ A minimum of 100 MB free disk space
◗ A minimum of 500 MB memory
◗ Additional disk space for customer data, archives, etc.

WARNING
For IBM® Sterling Gentran:Server® for UNIX, the UNIX host must 
include the Korn shell.

Operating
systems

This table lists the operating systems minimum requirements on the supported 
Sterling Gentran:Server platforms.  

Hardware Platform Operating System and Version

HP 9000 HPUX 11.31

IBM RS6000 A minimum of AIX 5.3 

SUN A minimum of Solaris 10      

 

 

    (SPARC only) 
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Supported Configurations xii
Patches
Hewlett-Packard provides service patches to their operating systems. You may 
need the service patches if you experience problems with message queues, the 
dynamic loader, performance, or the translator. We recommend that you check 
the Hewlett-Packard web site, or contact your Hewlett-Packard representative to 
obtain the most recent information about service patches.

Networking
requirements

Your Sterling Gentran:Server installation must satisfy the following networking 
requirements.

◗ Appropriate software for the EDI administrator to access the UNIX command 
line (Telnet or an x-emulation package).

◗ TCP/IP connectivity between UNIX host and Windows client computers.
Getting Started Guide – May 2011
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Lifecycle
requirements

The Sterling Gentran:Server Life Cycle auditing facility interfaces with most 
versions of:

◗ Informix
◗ Oracle
◗ Sybase

Contact IBM Customer Support to verify that a particular version of a database is 
supported.

This table lists, by vendor, the software that may be required to run Life Cycle.

Note
Check with your database vendor for current requirements.

Vendor Required Software Description

Informix ESQL/C Openline Embedded SQL precompiler

I-SQL Openline SQL statement interpreter

Informix Standard 
Engine (SE)

Standard database engine

Oracle PRO*C Embedded SQL precompiler for C source 
code

Oracle RDBMS Database server

PL/SQL SQL statement interpreter

Sybase Sybase SQL Server Database server

Open Client/C Necessary libraries to communicate with 
Sybase

Embedded SQL/C Embedded SQL precompiler for C source 
code
Getting Started Guide – May 2011
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Chapter Content

Description of
content

This table describes the content of the chapters within the IBM® Sterling 
Gentran:Server® Getting Started Guide.

Chapter Title Description

About this Guide This preface describes the purpose and content 
of this guide. It describes the supported 
hardware and software configurations.

Chapter 1 - Installing 
Sterling Gentran:Server on 
the UNIX Host

This chapter explains how to set up a new 
installation of Sterling Gentran:Server on a 
UNIX host computer.

The procedures include:

◗ preparing for installation
◗ installing Sterling Gentran:Server on the 

host
◗ setting up the Sterling Gentran:Server 

Security Administration utility.

Chapter 2 - Setting Up 
Windows Clients

This chapter explains how to install and set up 
client software for Sterling Gentran:Server on 
the Windows client computers.

Chapter 3 - Setting Up 
Communications

This chapter explains how to install and set up 
client software for Sterling Gentran:Server on 
the Windows client computers.

Chapter 4 - Introducing 
Sterling Gentran:Server

Describes the basic architecture of the Sterling 
Gentran:Server software.

Chapter 5 - Using Sterling 
Gentran:Server

Explains how to start and exit Sterling 
Gentran:Server, describes the user interface, 
and explains how to set default values for your 
system.

Chapter 6 - Working with 
Application Integration

Contains procedures for working with Sterling 
Gentran:Server Application Integration system 
files. Includes instructions for checking out, 
saving, and checking in files.
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Chapter Content  xv
Appendix A - Client 
Descriptions

Contains a table designed to help track serial 
numbers, IP addresses, and descriptions of 
your client PCs.

Glossary Sterling Gentran:Server and industry-related 
terms.

 (Contd)
Chapter Title Description
Getting Started Guide – May 2011
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Product Installation

Installation
process

We automated most of the installation process on both the UNIX host and the 
Windows client. 

◗ The host installation process prompts you for the necessary environment 
variables. The process collects the variables in a file that you can copy into 
scripts or attach to the profile of the appropriate user. 

◗ The client installation process helps configure the Sterling Gentran:Server 
connection to the UNIX host. The client installation now includes the ability to 
install online versions of the Sterling Gentran:Server documentation.

Note
This guide contains an additional procedure for setting up client/host 
communication for networks that use Domain Name Services (DNS). 

Installation
Checklist

The Installation Checklist contains the following features:

◗ Flow diagram of the installation process.
◗ Places to record all of the information you need during the installation 

process. 

We recommend that you keep the Installation Checklist with you for reference 
throughout the installation process.
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Optional Products

Introduction There are several options available for IBM® Sterling Gentran:Server® for UNIX 
6.2. They include:

◗ XML Translation extension (available for purchase)
◗ Health Insurance Portability and Accountability Act (HIPAA) features 

(available to all customers)
◗ Extensions (such as IBM® Sterling Gentran:Server® Extension for SAP R/3)

These options are installed automatically on the client. Access is limited, however, 
to only those options that have been installed on the UNIX host.

Installing
options

You can install each option separately after installing the core Sterling 
Gentran:Server software. This table lists the CD containing the option and the 
instructions for installing the option.

To install the… Use…

XML Translation 
Extension

the core installation CD. 

Note
You need to supply the serial number to install the XML 
Translation Extension.

Reference
See the How to Load and Install the XML Translation 
Option topic in this guide.

HIPAA features the IBM® Sterling Gentran:Server® for UNIX HIPAA 
Compliance and NCPDP User Guide.

Reference
See the How to Add a New Environment Record topic in 
this guide.

Extensions the documentation shipped with other options or add-on 
software for installation instructions.
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Related Publications

Sterling
Gentran:Server
documentation

This table describes additional documentation for the Sterling Gentran:Server 
software.

Document Description

IBM® Sterling 
Gentran:Server® for 
UNIX Upgrade and 
Data Conversion 
Guide

Instructions for upgrading from previous versions of 
IBM® Sterling Gentran:Server® for UNIX and IBM® 
Sterling Gentran:Server® for UNIX - Workstation. Also 
includes instructions for converting the files that are 
part of the upgrade.

IBM® Sterling 
Gentran:Server® for 
UNIX Installation 
Checklist

Description of the recommended sequence in which 
you should install and configure system components.

IBM® Sterling 
Gentran:Server® for 
UNIX - Workstation 
Getting Started Guide 

Instructions for installing the IBM® Sterling 
Gentran:Server® for UNIX - Workstation software and 
performing setup tasks.

Instructions for starting and exiting Sterling 
Gentran:Server and for setting preferences and default 
values. Also includes instructions for checking files in 
and out and saving files.

IBM® Sterling 
Gentran:Server® for 
UNIX Application 
Integration User 
Guide

Instructions for performing mapping and translation 
tasks using the Sterling Gentran:Server Application 
Integration system. 

IBM® Sterling 
Gentran:Server® for 
UNIX HIPAA 
Compliance and 
NCPDP User Guide

Instructions for mapping and translating NCPDP files 
with the Application Integration system.

IBM® Sterling 
Gentran:Server® for 
UNIX GENCOD User 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system.

IBM® Sterling 
Gentran:Server® for 
UNIX VDA User 
Guide

Instructions for mapping and translating VDA files with 
the Application Integration system.
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Related Publications  xix
IBM® Sterling 
Gentran:Server® for 
UNIX Technical 
Reference Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

IBM® Sterling 
Gentran:Server® for 
UNIX - EC 
Workbench Data Flow 
Administration Guide

User instructions for configuring data flows using the 
Sterling Gentran:Server software.

IBM® Sterling 
Gentran:Server® for 
UNIX - Process 
Control Manager Data 
Flow Administration 
Guide

User instructions for configuring data flows using the 
Sterling Gentran:Server software.

IBM® Sterling 
Gentran:Server® for 
UNIX Maintenance 
and Troubleshooting 
Guide

Instructions for maintaining your Sterling 
Gentran:Server installation. Also provides 
troubleshooting information to help determine the 
cause and solution of problems that may occur.

IBM® Sterling 
Gentran:Server® for 
UNIX - Workstation 
Maintenance and 
Troubleshooting 
Guide

Instructions for maintaining your workstation 
installation. Also provides troubleshooting information 
to help determine the cause and solution of problems 
that may occur.

IBM® Sterling 
Gentran:Server® for 
UNIX with ADD User 
Guide

Instructions for configuring and using the Advanced 
Data Distribution system.

IBM® Sterling 
Gentran:Server® for 
UNIX XML 
Translation User 
Guide

Instructions for mapping and translating XML files with 
the Application Integration system.

Document Description
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IBM® Sterling 
Gentran:Server® for 
UNIX with ADD FTP 
Daemon User Guide

Instructions for configuring and using the FTP Daemon 
tool with IBM® Sterling Gentran:Server® for UNIX with 
ADD.

Online Help Context-sensitive help screens describing the Sterling 
Gentran:Server dialog boxes and features. Also 
includes procedures for using the mapping and 
translation and the data flow administration software.

Document Description
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Overview 0

Introduction

Chapter contents This chapter contains instructions for installing Sterling Gentran:Server in a new 
environment.

WARNING
This installation method creates new, empty data files. Do not use 
this method to upgrade an existing Sterling Gentran:Server 
environment because it will overwrite existing data. 

Reference
See the IBM® Sterling Gentran:Server® for UNIX Upgrade and Data Conversion 
Guide for information about upgrading to a new version of Sterling 
Gentran:Server.

Stages of
Installation

When installing Sterling Gentran:Server, you must install at least one copy of the 
Security Administration utility and one copy of the Sterling Gentran:Server host 
installation software onto UNIX hosts on your network. The Security 
Administration and Sterling Gentran:Server installations must be on the same 
host. You must also load the Sterling Gentran:Server client software onto each 
Windows client computer that will access the Sterling Gentran:Server software.

This table describes the stages of a new installation process for Sterling 
Gentran:Server. Detailed instructions for completing each stage are contained in 
the rest of this manual.

Reference
See the IBM® Sterling Gentran:Server® for UNIX Upgrade and Data Conversion 
Guide for information about upgrading to a new version of Sterling 
Gentran:Server.

Stage Description

1 Prepare for installation:

◗ Create an administrative user to own and load the Security 
Administration utility.

◗ Create a Sterling Gentran:Server user to own the Sterling 
Gentran:Server host installation and processes.
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2 Install Sterling Gentran:Server on the host:

◗ Load the Security Administration installation files into a 
temporary area on the UNIX host computer.

◗ Install the Sterling Gentran:Server Security Administration 
utility.

◗ Load the Sterling Gentran:Server host installation files into 
a temporary area on the UNIX host computer.

◗ Install the Sterling Gentran:Server host software, including 
any options.

3 Configure the environment security for the Sterling 
Gentran:Server installation.

4 Configure the user security for the Sterling Gentran:Server 
installation.

5 Start the Sterling Gentran:Server processes on the UNIX host.

6 Install Sterling Gentran:Server on the Windows client.

 (Contd)
Stage Description
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Preparing for Installation 0

Overview

In this section This section contains procedures you must perform before installing the Sterling 
Gentran:Server host and client software.

Before you begin Use this table as a checklist to determine whether you are ready to install Sterling 
Gentran:Server.

Done Item

Make sure that you have:

◗ An Installation Checklist
◗ The host software CD
◗ The client software CD
◗ The IBM® Sterling Gentran® Standards CD
◗ The online documentation CD
◗ Any optional software that you want to install at this time

Complete the Installation Checklist, and keep it with you when 
performing the procedures in this chapter.
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How to Create an Administrative User

Introduction If different users perform separate parts of the installation, each user must have 
the same permissions and belong to the same group. 

Recommendations
We recommend that you create an administrative user and use that login to install 
the Security Administration utility software, configure Sterling Gentran:Server 
security, and start the security processes.

We recommend that you also create a separate Sterling Gentran:Server user for 
each Sterling Gentran:Server installation. If you have an older version of Sterling 
Gentran:Server on the same machine, you must create a new user profile to run 
the new version of Sterling Gentran:Server. The Sterling Gentran:Server user 
should have access to Sterling Gentran:Server, but not to administrative 
functions. For instructions, see the How to Create a Sterling Gentran:Server User 
topic in this chapter.

Procedure Use this procedure to create an administrative user to install and own the Security 
Administration software, start the processes, and configure security.

Comment
Depending on how system security is handled at your site, a system administrator 
may have to create this user for you. 

Step Action

1 Log on to the UNIX host as root.

2 Create a UNIX user login.

Example
gsadmin

3 Create a group containing the new user.

Example
gsuser
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4 Create a directory to contain the Sterling Gentran:Server 
Security Administration utility. Set ownership of this directory to 
the user and group you created in Steps 2 and 3.

Comment
For the Sterling Gentran:Server Security Administration utility 
to work properly, the user must be the owner or a member of 
the group that owns the Sterling Gentran:Server Security 
directory.

5 Are you installing Sterling Gentran:Server for UNIX?

◗ If YES, give the administrator at privileges to allow the 
administrator to start scripts.

WARNING
The Sterling Gentran:Server data flow software will 
work properly only if the user has the ability to start 
scripts.

Comment
Permission to start at jobs is maintained in the at.allow or 
at.deny files. These files are normally found in /usr/admin/
cronq or /usr/lib/cron, depending on the version of UNIX you 
are running.

6 Give the administrator cron privileges to allow the 
administrator to start cron jobs. 

WARNING
The Sterling Gentran:Server Scheduler requires cron 
privileges to function.

Comment
Permission to start cron jobs is maintained in the cron.allow or 
cron.deny files. These files are normally found in /usr/admin/
cronq or /usr/lib/cron. The actual location may vary, depending 
on the version of the UNIX system you are running.

 (Contd)
Step Action
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How to Create a Sterling Gentran:Server User

Introduction You should create a separate Sterling Gentran:Server user login to each 
environment and that you use that login to start the Sterling Gentran:Server 
processes within that environment.

Procedure Use this procedure to create a Sterling Gentran:Server user to install and run the 
Sterling Gentran:Server installation.

Comment
Depending on how system security is handled at your site, a system administrator 
may have to create this user. 

Step Action

1 Log on to the UNIX host as root. 

2 Create a UNIX user login.

Example
gsprod

3 Add the user to the group containing the administrative login.

Example
gsuser

4 Create a directory for the Sterling Gentran:Server installation. 
Set ownership of this directory to the user and group you 
created in Steps 2 and 3.

WARNING
Do not use spaces or other punctuation within the 
directory name.
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5 Are you installing IBM® Sterling Gentran:Server® for UNIX ?

◗ If YES, give the user at privileges. This allows the 
administrator to start scripts.

WARNING
The Sterling Gentran:Server data flow software will 
work properly only if you have privileges to start 
scripts.

Comment
Permission to start at jobs is maintained in the at.allow or 
at.deny files. These files are normally stored in /usr/admin/
cronq or /usr/lib/cron. The location is dependent on which 
version of the UNIX system you are running.

6 Give the user cron privileges to allow the user to start cron 
jobs. 

WARNING
The Sterling Gentran:Server Scheduler requires cron 
privileges to function.

Comment
Permission to start cron jobs is maintained in the cron.allow or 
cron.deny files. These files are normally found in /usr/admin/
cronq or /usr/lib/cron. The location is dependent on which 
version of the UNIX system you are running.

 (Contd)
Step Action
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Installing the Software on 
the UNIX Host 0

Overview

In this section This section explains how to load Sterling Gentran:Server from the installation CD 
into the proper directories on the UNIX host computer. 

Installation
Checklist

We recommend that you keep the Installation Checklist with you for reference 
throughout the installation process.

The Installation Checklist contains the following features:

◗ Flow diagram of the installation process.
◗ Places to record all of the information you need during the installation 

process. 
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How to Load Security Installation Files

Introduction During installation, you must run a transfer program to copy the compressed 
software files from the installation CD into the proper directories on the UNIX host 
computer. This topic explains how to use the transfer program to read the security 
installation files from a CD in a Windows client computer into a temporary 
directory on the UNIX host.

Before you begin Before you begin loading the Sterling Gentran:Server security installation files 
onto the UNIX host computer, you must have a UNIX login to install and own the 
Security Administration utility.

References
See the How to Create an Administrative User topic in this chapter for detailed 
instructions on creating this login.

Copying
installation files

from the CD

Use this procedure to copy the security installation files from a CD-ROM drive on 
the Windows client computer to the UNIX host.

Note

Before you begin, verify that

◗ The connection between the Windows client and the UNIX host supports 
TCP/IP.

◗ The Windows client computer is connected to the UNIX host.

Step Action

1 Insert the Sterling Gentran:Server host installation CD into a CD-
ROM drive in the Windows client. 

2 ◗ For Window 7, click Start > All Programs > Accessories, and 
then click on the Command Prompt.

◗ For Windows XP, click Start > All Programs > Accessories - XP, 
and then click on the Command Prompt.

3 Change directories to the CD-ROM drive on the Windows computer.
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4 Type the following command to copy the security installation files 
from the CD to a temporary area on the UNIX host. 

ftpprod security <host> <path> <user> <password>

Where

◗ <host> is the system name for the UNIX host
◗ <path> is the path to a temporary directory (The ftpprod 

process creates the directory if necessary)
◗ <user> is the user login for the administrative user you created
◗ <password> is the user password for the administrative user

5 Press ENTER.

System Response
The transfer program displays information about the transfer 
process. The message “Files transferred” indicates that the process 
completed successfully.

6 Close the DOS window.

7 Continue to How to Install Security Administration Software to install 
the security software from the temporary directory.

 (Contd)
Step Action
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How to Install Security Administration Software

Introduction The Sterling Gentran:Server Security Administration utility controls the Sterling 
Gentran:Server software. Run the secsetup.sh script to install the software for this 
utility into the appropriate directories on the UNIX host. 

The secsetup.sh script 

◗ reads the installation files
◗ installs them into the specified location on the UNIX host
◗ temporarily sets the UNIX environment variables that the security software 

needs
◗ places those variables into a file that you can include in scripts and UNIX 

users’ profiles.

This topic explains how to run secsetup.sh to install the security software files into 
a security administration directory. It also explains how to add the environment 
variables into the security administrator profile. 
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Before you begin Use this checklist to ensure that you are ready to begin installing the Sterling 
Gentran:Server Security Administration utility onto the UNIX host computer. 

CAUTION
During the setup process, the setup program prompts you for a 
required environment variable if it is not set. If the setup program 
finds a value for a required environment variable, it continues to the 
next step without displaying a prompt.

Done Task

Log onto the UNIX host machine as the administrative user that 
was set up to install and own the security administration 
installation.

Reference
See the How to Create an Administrative User topic in this chapter 
for detailed instructions on creating this user.

Verify that the compressed security installation files reside in a 
temporary directory on the UNIX host that this login is accessing. 

Reference
See the How to Load Security Installation Files topic in this chapter 
for detailed instructions.
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Installing the
Security

Administration
utility

Use this procedure to install the Sterling Gentran:Server Security Administration 
utility on the UNIX host computer. Refer to the completed Installation Checklist as 
needed.

Step Action

1 Log onto the UNIX host as the administrative user that will 
install and own this installation.

WARNING
You must log on as the user who will own the 
security directories and start the security processes. 
Using another login will result in conflicts with 
permissions. 
Do not log on as root. The root login is unable to run 
the installation program.

Reference
See the topic How to Create an Administrative User in this 
chapter for instructions.

2 Change directories to the temporary directory.

Example
cd temp

3 Give yourself “execute” privileges for the secsetup.sh script 
file. This gives you permission to run the script.

Example
chmod +x secsetup.sh

4 Type the following command at the UNIX prompt and then 
press ENTER:

./secsetup.sh 

System Response
The secsetup.sh script displays information about the 
installation process and prompts you to enter a value for 
SADMIN_ROOT. 
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5 Type the complete path you want secsetup.sh to use when 
installing the security utility and press ENTER.

Example
/usr1/gentran/security

System Response
The secsetup.sh script displays the path entered and prompts 
you to confirm that the path is correct.

6 Is the path displayed correct?

◗ If YES, type y and press ENTER.

◗ If NO, type n and press ENTER. The secsetup.sh script 
again prompts you to enter a value for SADMIN_ROOT. 
Return to Step 5.

System Response
The secsetup.sh script prompts you for the complete path to 
the vvtermcap file.

7 Do you want to use the vvtermcap file supplied by IBM? 

◗ If YES, press ENTER to accept the default path. 

Note
We recommend that you accept the default. Use 
another file only if your system requires a proprietary 
terminal emulator.

◗ If NO, type the path to where your proprietary vvtermcap 
file is stored, and press ENTER. (Contact your system 
administrator if you do not know the path.)

System Response
The secsetup.sh script displays the path entered for the 
vvtermcap file and prompts you to confirm that value. 

 (Contd)
Step Action
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8 Is the displayed VVTERMCAP value correct?

◗ If YES, type y and press ENTER.

◗ If NO, type n and press ENTER. The secsetup.sh script 
prompts you a second time to enter a value for 
VVTERMCAP. Return to Step 7.

System Response
The secsetup.sh script prompts you for a value for the 
VVTERM environment variable. 

Comment
This value reflects the terminal emulation setting to use for 
Sterling Gentran:Server. It normally equals the TERM 
environment variable value set in your profile. 

9 Do you want to use the default value, which sets VVTERM to 
the same value as TERM? 

◗ If YES, then press ENTER.

◗ If NO, type the value you want to use for VVTERM, and 
press ENTER. 

Comment
A common value is vt100.

System Response
The secsetup.sh script displays the value entered and 
prompts you to confirm the value.

10 Is the displayed VVTERM value correct?

◗ If YES, type y and press ENTER.

◗ If NO, type n, and press ENTER. The secsetup.sh script 
prompts you to enter a value for VVTERM a second time. 
Return to Step 9.

System Response
The secsetup.sh script prompts you for a value for the 
NAMEBROKER environment variable. 

11 Type the system name for the UNIX computer that will run the 
broker process that controls this security installation.

System Response
The secsetup.sh script displays the value entered and 
prompts you to confirm the value.

 (Contd)
Step Action
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Adding
environment

variables to the
owner profile

Use this procedure to add the environment variables saved by secsetup.sh into 
the profile of the security administrator.

12 Is the displayed NAMEBROKER value correct?

◗ If YES, type y and press ENTER.

◗ If NO, type n and press ENTER. The secsetup.sh script 
prompts you a second time to enter a value for 
NAMEBROKER. Return to Step 11.

System Response
The secsetup.sh script displays status messages and lists the 
path to the file that contains the environment variables. 

13 View the installation log to confirm that the installation 
completed successfully.

Comment
The system creates the installation log (secsetup.log) in the 
directory where you started the secsetup.sh script. 

14 Do you want to install another copy of the Security 
Administration utility to control a second Sterling 
Gentran:Server environment?

◗ If YES, then return to Step 1 and repeat this procedure.
◗ If NO, then continue with the next procedure, Adding 

environment variables to the owner profile.

Note
You can use a single security installation to control multiple 
Sterling Gentran:Server environments on the same UNIX host 
machine. Each UNIX host machine running Sterling 
Gentran:Server must have a security installation.

 (Contd)
Step Action

Step Action

1 If you logged off of the UNIX host, log back on as the 
administrative user.

Reference
See the How to Create an Administrative User topic in this 
guide for instructions.

2 Change directories to the home directory for the administrative 
user.
Getting Started Guide – May 2011



How to Install Security Administration Software Installing Sterling Gentran:Server On the UNIX Host1 - 18
3 Use a text editor to open the profile (.profile or .login) of the 
administrative user.

Reference
See the documentation provided with the text editor for more 
information about opening files.

4 Open a second session on the UNIX host while keeping the 
first session open.

5 Open the gentran.security.vars file and add the last set of 
values to the end of the profile.

CAUTION
The installation process appends new values at the 
end of the gentran.security.vars file each time you 
run secsetup.sh using the same UNIX login. 
Depending on the size of the file and the text editor 
you are using, it may be easier to locate the values 
that you need to copy by printing the file first.

6 Save the modified profile.

7 Log the administrative user off the system.

8 Log onto the system again as the administrative user. 

System Response
The system sets the environment variables for the 
administration user using the values from the edited profile. 

 (Contd)
Step Action
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How to Load Sterling Gentran:Server Host Installation 
Files

Introduction During installation, you must run a transfer program to copy the compressed 
software files from the installation CD into the proper directories on the UNIX host 
computer. This topic explains how to use the transfer program to read the 
installation files from a CD in a Windows client computer into a temporary 
directory on the UNIX host.

Before you begin Before you begin loading the Sterling Gentran:Server installation files onto the 
UNIX host computer, you must have a UNIX login to install and own the Security 
Administration utility.

IMPORTANT
You must load the Security Installation files and install the Security 
Administration software before loading the Sterling Gentran:Server 
Host installation files.

References
See the How to Create an Administrative User topic in this chapter for detailed 
instructions on creating this login.

Copying
installation files

from the CD

Use this procedure to copy the installation files from a CD-ROM drive on the 
Windows client computer to the UNIX host.

Note
Before you begin, verify that

◗ The connection between the Windows client and the UNIX host supports 
TCP/IP

◗ The Windows client computer is connected to the UNIX host.

Step Action

1 Insert the Sterling Gentran:Server host installation CD into a 
CD-ROM drive in the Windows client. 

2 ◗ For Window 7, click Start > All Programs > Accessories, 
and then click on the Command Prompt.

◗ For Windows XP, click Start > All Programs > Accessories - 
XP, and then click on the Command Prompt.
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3 Change directories to the CD-ROM drive on the Windows 
computer. 

Example
D:

4 Type the following command to transfer installation files from 
the CD to a temporary area on the UNIX host:

ftpprod <product> <host> <path> <user> <password>

Where

◗ <product> is the product code for the Sterling 
Gentran:Server you purchased. Use the following value,
add=IBM® Sterling Gentran:Server® for UNIX with ADD

◗ <host> is the system name for the UNIX host
◗ <path> is the path to a temporary directory (The ftpprod 

process will create the directory if necessary)
◗ <user> is the user login for the administrative user you 

created
◗ <password> is the user password for the administrative 

user

Example
ftpprod add sun2 /usr/gentran/temp secuser secpassword

5 Press ENTER.

System Response
The transfer program displays information about the transfer 
process. The message “Files transferred” indicates that the 
process completed successfully.

6 Close the DOS window.

7 Continue to How to Install the Sterling Gentran:Server Host 
Software to install the security software from the temporary 
directory.

 (Contd)
Step Action
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How to Install the Sterling Gentran:Server Host 
Software

Introduction You run the setup.sh script to install the Sterling Gentran:Server host software into 
the appropriate directories on the UNIX host. 

The setup.sh script reads the installation files and installs them into the specified 
location on the UNIX host. This script also sets temporary values for some of the 
UNIX environment variables that the Sterling Gentran:Server software needs. The 
installation script places those variables into a file that you can include in scripts 
and UNIX users’ profiles.

This topic explains how to run setup.sh to install the Sterling Gentran:Server 
software files into a directory and then add the environment variables into the 
administration user profile or to scripts. 

IMPORTANT
Before you install the Sterling Gentran:Server host software, you 
must compete the following tasks: load the Security Installation files; 
install the Security Administration software; and load Sterling 
Gentran:Server host software files

Before you begin Use this checklist to determine that you are ready to install Sterling 
Gentran:Server onto the UNIX host computer. 

CAUTION
During the setup process, the setup program prompts you for a 
required environment variable if it is not set. If the setup program 
finds a value for a required environment variable, it continues to the 
next step without displaying a prompt.

Done Task

Verify that you created a Sterling Gentran:Server user to own 
the environment and the processes run within it.

Verify that you correctly installed a copy of the Security 
Administration utility to control the Sterling Gentran:Server 
environment.
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Installing the
Sterling

Gentran:Server
software

Use this procedure to install the Sterling Gentran:Server software onto the UNIX 
host computer. Refer to the completed Installation Checklist as needed.

Step Action

1 Log on to the UNIX host as the Sterling Gentran:Server user 
that owns the host software.

WARNING
You must log on as the user who will own the Sterling 
Gentran:Server environment. Using another login will 
result in conflicts with permissions. 
Do not log on as root. The root login is unable to run 
the installation program.

Reference
See the topic How to Create a Sterling Gentran:Server User for 
instructions on this task.

2 Change directories to the temporary directory you used as the 
path in the ftpprod in Step 5 of “How to Load Sterling 
Gentran:Server Host Files.”

3 Give “execute” privileges for the setup.sh script file so it can 
be run by the Sterling Gentran:Server user.

Example
chmod +x setup.sh

4 Type the following command and press ENTER.

./setup.sh 

System Response
The setup.sh script displays information about the installation 
process and prompts you to provide the product key for the 
Sterling Gentran:Server product you want to install.

5 Type the product key and press ENTER.

System Response
The setup.sh script prompts you for the path to the location 
where Sterling Gentran:Server will be installed.

 Note: If you are installing on the SunOS/Solaris platform, only SPARC is supported. If you    
attempt to install on x86 or x86-64, the system will respond positively ("Version xx.x meets 
or exceeds our minimum requirements") but the install will fail with an error message. 
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6 Type the complete path to where you want setup.sh to install 
the Sterling Gentran:Server software and press ENTER.

Example
/usr1/gentran/edi

System Response
The setup.sh script displays the path you entered and prompts 
you to confirm that the path is correct.

7 Is the displayed path correct?

◗ If YES, type y and press ENTER.

◗ If NO, type n and press ENTER. The setup.sh script 
prompts you a second time to enter a value for EDI_ROOT 
and ENV_ROOT. Return to Step 6.

System Response
The setup.sh script prompts you for the complete path to the 
vvtermcap file.

8 Do you want to use the vvtermcap file supplied by IBM? 

◗ If YES, press ENTER to accept the default path. 

Note
We recommend that you accept the default. Use 
another file only if your system requires a proprietary 
terminal emulator.

◗ If NO, type the path to where your proprietary vvtermcap 
file is stored and press ENTER. (Your system administrator 
can provide this path if you need it.)

System Response
The setup.sh script displays the path entered for the 
vvtermcap file and prompts you to confirm that value. 

9 Is the displayed VVTERMCAP value correct?

◗ If YES, type y and press ENTER.
◗ If NO, type n and press ENTER. The setup.sh script 

prompts you a second time to enter a value for 
VVTERMCAP. Return to Step 8.

Comment
This value reflects the terminal emulation setting to use for 
Sterling Gentran:Server, and normally is the same as the value 
for the TERM environment variable as set in your profile. 

 (Contd)
Step Action
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10 Do you want to install in the <filename> directory? 

◗ If YES, type y and press ENTER.

◗ If NO, type n and the directory you want to use. Press 
ENTER. 

System Response
The setup.sh script runs. It creates directories, installs the EDI 
software, and creates empty data files. After all files are 
installed, the installation validation program verifies that 
Sterling Gentran:Server can run successfully. Validation 
collects the validated environment variable settings in a file, 
and creates a log file that records any problems detected.

Note
The validation stage lasts several minutes for the lowest 
product level. This stage lasts longer for higher product levels.

Eventually, the setup.sh script displays status messages and 
lists the path to the file that contains the environment variables. 

11 View the installation log to confirm that the installation 
completed successfully.

Comment
The system creates the installation log (setup.log) in the 
directory where you started setup.sh. 

12 Continue with the next procedure, Adding environment 
variables to the owner profile.

 (Contd)
Step Action
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Adding
environment

variables to the
owner profile

Use this procedure to add the required environment variables saved by 
secsetup.sh and by setup.sh into the profile of the environment owner.

Note
This procedure requires you to open two sessions on the UNIX host. 

Step Action

1 If you logged off the UNIX host, log back onto the UNIX host as 
the Sterling Gentran:Server user created to own this 
environment. 

Reference
See the How to Create a Sterling Gentran:Server User topic 
for instructions.

2 Change directories to the home directory for the Sterling 
Gentran:Server user.

3 Use any text editor to open the profile (.profile or .login) of the 
Sterling Gentran:Server user.

4 Open a second session on the UNIX host while keeping the 
first session open.

5 Log onto the second session as the Sterling Gentran:Server 
user.

Comment
You can make the rest of this procedure easier to perform by 
resizing the session windows side-by-side.

6 Change directories in the second session to the home 
directory of the owner of the security installation.

7 Open the gentran.security.vars file and copy the command that 
sets NAMEBROKER from the last set of values.

CAUTION
The installation process appends new values at the 
end of the gentran.security.vars file each time you 
run secsetup.sh using the same UNIX login. 

Comment
Depending on the size of the file and the text editor you are 
using, it may be easier to locate the values that you need to 
copy by printing the file first.

8 Paste the NAMEBROKER command into the profile in the first 
session window.
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9 From the gentran.security.vars file in the second session 
window, copy the command that sets SADMIN_ROOT.

10 Paste the SADMIN_ROOT command into the profile in the first 
session window.

11 Change directories in the second session window to the home 
directory for the Sterling Gentran:Server user.

12 Open the gentran.server.vars file and copy the environment 
variables.

WARNING
The installation process appends new values at the 
end of the gentran.server.vars file each time you run 
setup.sh using the same UNIX login. 

Comment
Depending on the size of the file and the text editor you are 
using, it may be easier to locate the values that you need to 
copy by printing the file first.

13 Paste the commands at the end of the profile in the first 
session.

14 Save the modified profile.

15 Log the Sterling Gentran:Server user off of both sessions and 
then log this user back on to the host again.

System Response
The system sets the environment variables for the Sterling 
Gentran:Server user using the values from the edited profile. 

16 Do you want to install the optional XML Translation extension?

◗ If YES, see How to Load and Install the XML Translation 
Option for further instructions.

◗ If NO, continue to the next step.

17 Do you want to install another copy of the Sterling 
Gentran:Server software?

◗ If YES, then repeat the previous procedure, Installing the 
Sterling Gentran:Server software.

◗ If NO, then you are ready to set up security for your new 
installation. Continue with the section, Setting Up Sterling 
Gentran:Server Security.

 (Contd)
Step Action
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How to Load and Install the XML Translation Option

Introduction To install the optional XML translation extension, you copy the compressed 
software files from the installation CD into a temporary directory on the host, and 
then run the installation script xmlsetup.sh to install the software into the 
appropriate directory on the host.

Note
The XML translation extension is automatically installed on the Windows client 
computer. It cannot be accessed until this installation process in completed on the 
host computer, however.

Before you begin You must first install the core Sterling Gentran:Server software before you can 
install the optional XML extension. See How to Install the Sterling Gentran:Server 
Host Software for instructions.

CAUTION
During the setup process, the setup program prompts you for a 
required environment variable, if the variable has not been set. If the 
setup program finds a value for a required environment variable, it 
continues to the next step without displaying a prompt.

Procedure Use this procedure to load and install the optional XML translation extension.

Step Action

1 Log on to the UNIX host as the Sterling Gentran:Server user that 
owns this environment.

WARNING
You must log on as the user who owns the Sterling 
Gentran:Server environment. Using another login will 
result in conflicts with permissions. 
Do not log on as root. The root login is unable to run the 
installation program.

Reference
See the topic How to Create a Sterling Gentran:Server User for 
instructions on this task.

2 Insert the Sterling Gentran:Server host installation CD into a CD-
ROM drive in the Windows client. 
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3 ◗ For Window 7, click Start > All Programs > Accessories, and 
then click on the Command Prompt.

◗ For Windows XP, click Start > All Programs > Accessories - XP, 
and then click on the Command Prompt.

4 Change directories to the CD-ROM drive on the Windows computer.

Example
D:\

5 Type the following command to transfer XML installation files from 
the CD to a temporary area on the UNIX host:

ftpprod xml <host> <path> <user> <password>

Where

◗ <host> is the system name for the UNIX host
◗ <path> is the path to a temporary directory (The ftpprod 

process will create the directory if necessary)
◗ <user> is the user login for the administrative user you created
◗ <password> is the user password for the administrative user

Example
ftpprod xml sun2 /usr/gentran/tempxml secuser secpassword

6 Press ENTER.

System Response
The transfer program displays information about the transfer 
process. The message “Files transferred” indicates that the process 
completed successfully.

7 On the UNIX host, change directories to the temporary directory 
specified by <path> in Step 6.

8 Give “execute” privileges for the xmlsetup.sh script file so it can be 
run by the Sterling Gentran:Server user.

Example
chmod +x xmlsetup.sh

 (Contd)
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9 Type the following command and press ENTER.

./xmlsetup.sh 

System Response
The xmlsetup.sh script displays information about the installation 
process. The system then prompts you to enter the serial number for 
your XML Translation software.

10 At the prompt, type values for the EDI_ROOT and ENV_ROOT 
environment variables.

Example
/edibox1/server61/ediprod

System Response
The system displays this prompt: Is this correct: [value for variables] 
(y/n)

11 Do you want to run the validation program?

◗ If YES, type y at the prompt and continue with Step 14.
◗ If NO, type n at the prompt to complete the installation process.

12 View the installation log to confirm that the installation completed 
successfully.

Comment
The system creates the installation log (xmlsetup.log) in the 
directory where you started xmlsetup.sh. 

 (Contd)
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Setting Up Sterling 
Gentran:Server Security 0

Overview

In this section This section explains how to use the Security Administration utility to:

◗ Set up each newly-installed Sterling Gentran:Server environment.
◗ Set up the Sterling Gentran:Server users for each newly-configured 

environment.
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Sterling Gentran:Server Directories and Permissions

Directory names The Security Administration Utility is installed into the directory you specified for 
the SADMIN_ROOT environment variable. The directory SADMIN_ROOT 
contains the following subdirectories:

Directory
permissions

This table shows the recommended read (r), write (w), execute (x), and no 
permission (–) file permissions for the Security Administration directories.

Subdirectory Contents

broker Executable and database files for the NAMEBROKER

admin Security Administration executable files

db Security Administration database files

temp Security Administration temporary files

Directory

Permission Group

Owner Group
User/
Other

broker r w x r w x – – –

admin r w x r w x – – –

db r w x r w x – – –

temp r w x r w x – – –
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How to Start and Exit Security Administration

Login screen Enter the security administrator password on the Security Administration login 
screen.

Before you begin Before you attempt to start Security Administration, check with your UNIX 
administrator to ensure that you have the appropriate file permissions to the 
Security Administration directories.
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Starting Security
Administration

Use this procedure to start Security Administration.

If you forget your
password

If you forget your security administrator password, you must call IBM Customer 
Support to reset it.

Step Action

1 Go to the UNIX command line.

2 Use this table to determine your next action.

IF the Security Administration 
subdirectory security/admin 
is… THEN…

In your path Enter the command:

secadmin

Not in your path Change to the admin 
subdirectory.

Enter the command:
secadmin

System Response
The system displays the Security Administration login screen.

3 Type the security administrator password in the Password field and 
press ENTER.

System Response
The system displays the Main Menu.

CAUTION
If you are logging in for the first time, the password is 
ADMIN. You should change this password immediately 
after logging in. See the topic How to Change the 
Security Administrator Password in the Security 
Administration Overview chapter of the IBM® Sterling 
Gentran:Server® for UNIX Maintenance and 
Troubleshooting Guide.
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Exiting Security
Administration

Use this procedure to exit Security Administration.

Example This illustration shows how to exit Security Administration.

Step Action

1 Press ESC twice to return to the Main Menu.

2 Press X to exit.

To exit Security 
Administration press X
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How to Add a New Environment Record

Introduction To create a new environment on a host, you enter all of the new environment data 
into a blank Environment Administration screen. Security Administration copies 
required files from the db subdirectory into the new environment record.

Before you begin Make sure you are logged on to the Security Administration utility as the UNIX 
user who installed the Sterling Gentran:Server Security Administration utility. This 
ensures that you have the appropriate permissions for the security directories.

Procedure Use this procedure to add an environment record.

Step Action

1 Select Environment Administration from the Security 
Administration Main Menu to display the Environment 
Administration screen.

2 Type the name of the new environment in the Environment field. 

3 Press ENTER. 

System Response
The system displays the prompt “Environment not found. Do You 
Wish to Add?”

4 Select Yes and press ENTER to continue.

System Response
Security Administration enters the name from Step 2 into the 
Environment field of the Environment Administration screen.
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5 Type the complete path to $EDI_ROOT into the first field on the 
Environment Administration screen and then press ENTER.

WARNING
The path of the root directory must be unique to the 
environment. All other paths may either be unique or 
shared among two or more environments.

System Response
Security Administration creates appropriate entries for all of the 
other fields, basing them on the root directory you enter.

6 Check the path in every field on the Environment Administration 
screen and edit them if necessary.

7 Do you want to enable Sterling Gentran:Server features that 
support the Health Insurance Portability and Accountability Act 
(HIPAA)?

◗ If YES, type Y in the HIPAA Features field.
◗ If NO, type N in the HIPAA Features field.

Reference
See the IBM® Sterling Gentran:Server® for UNIX HIPAA 
Compliance and NCPDP User Guide for information about the 
HIPAA features of Sterling Gentran:Server.

8 Press F10 to save the record.

Comment
Press ESC+0 if your terminal emulator is set to vt100.

 (Contd)
Step Action
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CAUTION
Security Administration automatically creates the parent directories 
when you choose to create the subordinate directory.

9 Use this table to determine your next action.

IF…
THEN Security 
Administration… AND you should…

All the directories 
you specified exist

Saves the 
environment record 
and refreshes the 
screen

Add another 
environment or exit 
the screen.

Either the root or 
temporary directory 
is not unique

Displays an error 
message

Correct the record 
by typing a unique 
directory path name 
in the Root 
Directory or 
Temporary field.

A specified directory 
does not exist

Displays a 
confirmation panel 
for each directory 
that does not exist

Select Create to 
create the directory 
or select Change to 
specify another 
directory.

 (Contd)
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Example of
completed

Environment
Administration

screen

The following is an example of a completed Environment Administration screen. 
For field descriptions, see the The Environment Administration Screen topic in the 
IBM® Sterling Gentran:Server® for UNIX Maintenance and Troubleshooting 
Guide.
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How to Add a User Record

Introduction You can add a new user record by doing one of the following:

IF you... THEN...

Need to build your user ID records Enter all user information into the blank 
fields on the User Administration screen.

Do not have an existing user ID 
record that is similar to the one you 
need

Enter all user information into the blank 
fields on the User Administration screen.

Have an existing user ID record that 
is similar to the one you need

Copy the entire user record, including all 
the environmental-level and function-
level access permissions, and modify it 
as necessary.
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Entering new
user information
on blank panels

Use this procedure to add a new user record.

Step Action

1 Select User Administration from the Main Menu.

System Response
The system displays the User Administration screen.

2 Type the new user ID in the User ID field and then press ENTER.

Comment
The field accepts up to 15 alphanumeric characters. Do not use 
spaces or any punctuation.

System Response
If the user ID does not exist, the system displays the following 
panel:
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3 Select Yes to add the new user ID.

System Response
The system displays the Change Password panel. This panel is 
used to set the user’s initial password.

4 Type the password you want to assign to this user in the New 
Password field and then press ENTER.

Comment
The field accepts up to 15 alphanumeric characters. Do not use 
spaces or any punctuation.

5 Type the password again in the Verification field.

6 Press F10.

Comment
Press ESC-0 if your terminal emulator is vt100.

WARNING
If the password entered in the New Password field does 
not match the password entered in the Verification field, 
Security Administration displays the message 
“Verification error - Retry.” Press ESC to remove the error 
message from your display. Retype the password in the 
New Password and Verification fields. 

 (Contd)
Step Action
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7 Use this table to determine your next action.

IF you… THEN…

Do not need to create more 
users

Continue with the topic How to 
Assign Access to an Environment 
and Its Functions.

Need to create more users 
and some of the users 
need the same access to 
the environment

Continue with the topic How to 
Assign Access to an Environment 
and Its Functions.

Suggestion
After you set all security access for 
this user, use the procedure Copying 
a user record to create new users 
with the same access.

Need to create more users 
and all of the users need 
different environment 
access 

Repeat Steps 1 through 6 for each 
additional user.

 (Contd)
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Copying a user
record

Use this procedure to copy a user record.

Step Action

1 Select User Administration from the Main Menu.

2 Press F2 and choose the user ID from the choice list.

Comment
Press ESC-2 if your terminal emulator is vt100.

System Response
The system displays the user information.

3 Press F4.

Comment
Press ESC-4 if your terminal emulator is vt100.

System Response
The system displays the Copy User ID panel.
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4 On the Copy User ID panel, type the ID of the new user in the New 
User ID field. 

Comment
The field accepts up to 15 alphanumeric characters. Do not use 
spaces or any punctuation.

5 Press F10.

Comment
Press ESC-0 if your terminal emulator is vt100.

System Response
The system displays the Change Password panel.

6 In the New Password field, type the password you want to assign 
to this user and press ENTER.

7 Type the password again in the Verification field.

8 Press F10.

Comment
Press ESC-0 if your terminal emulator is vt100.

WARNING
If the password you typed in the New Password field 
does not match the password you typed in the 
Verification field, Security Administration displays the 
message “Verification error - Retry.” Press ESC to remove 
the error message from your display and then retype the 
password in the New Password and Verification fields. 

 (Contd)
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Comment
After you create the new user ID record, you can modify it as needed. See the 
topic How to Assign Access to an Environment and Its Functions in this chapter 
for instructions. 
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Environment Access

Introduction You can assign a single environment to any number of user IDs. You can also 
assign a number of environments to a single user ID. After assigning an 
environment to a user, select the function groups of the environment and assign 
an access code to each function in each group.

Function levels
and

classifications

Environments have two function groups: editor and program.

Editor group
The editor functions enable the user to modify files. 

Editor functions have three access levels:

◗ No access (user has no access to the function or the files)
◗ View-only access (user can only view files)
◗ Full access (user has access to all capabilities of editor, such as viewing, 

copying, editing, loading, unloading, and renaming files)

Program Group
Program functions are executable programs. 

Program functions have two access levels:

◗ Full access (user can run the program)
◗ No access (user cannot run the program)

Screens used to
assign

environment
level access

These screens are used to assign the environment and function-level access:

◗ User Environment Administration
◗ User Function Administration

Descriptions of these two screens follow this topic.
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User
Environment

Administration
screen

This illustration shows the User Environment Administration screen.

Purpose The User Environment Administration screen is used to assign an environment to 
a user ID.

Fields and
functions

This table describes the fields of the User Environment Administration screen and 
their functions.

Function keys This table lists the function keys on the User Environment Administration screen 
and their functions.

Field Function

User ID The characters that identify the user record to the 
system.

Environment The name of the environment to which the user ID is 
granted access.

Key Function

ESC Exits the screen.

Comment
Press ESC-ESC if your terminal emulator is vt100.

F1 Displays Help information.

Comment
Press ESC-1 if your terminal emulator is vt100.
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User Function
Administration

screen

This illustration shows the User Function Administration screen (Program function 
group) for IBM® Sterling Gentran:Server® for UNIX - EC Workbench.

F2 Displays a list of all possible choices for the field that contains 
the cursor.

Comment
Press ESC-2 if your terminal emulator is vt100.

F6 Displays a list of values already assigned to the field that 
contains the cursor.

Comment
Press ESC-6 if your terminal emulator is vt100.

 (Contd)
Key Function
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Purpose The purpose of this screen is to assign the type of access the user is to have to 
each function in the environment.

Fields and
functions

This table describes the fields of the User Function Administration screen and 
their functions.

Function keys This table lists the function keys on the User Function Administration screen and 
their functions.

Field Function

User ID The characters that identify the user record to the 
system.

Environment The name of the environment to which the user ID is 
granted access.

Function Group The predefined name of the function group (Editors or 
Programs).

Function 
Description

The predefined functions within the function group.

Type The function type:

◗ E = Editor
◗ N = Non-Editor

Access The access code:

◗ F = Full access
◗ N = No access
◗ V = View-only access

 
Key Function

ESC Exits the screen.

F1 Displays Help information.

F3 Denies access for every function (places an N in every field.)

F4 Grants access for every function (Places an F in every field.)
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F5 Grants view-only access for every editor function (Places a V in 
every access field.) This option is not available for Programs.

F7 Displays this screen for the next User ID.

F8 Displays this screen for the previous User ID.

F10 Saves the information you entered.

 (Contd) 
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How to Assign Access to an Environment and Its 
Functions

Procedure Use this procedure to assign access to an environment.

Step Action

1 Select User Administration from the Main Menu.

2 Press F2 and select the user ID from the list displayed.

Comment
Press ESC-2 if your terminal emulator is vt100.

System Response
The system displays the User Information screen.
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3 Press F5 to set up the user environment.

Comment
Press ESC-5 if your terminal emulator is vt100.

System Response
The system displays the User Environment Administration screen.

4 Press F2 and choose the environment you want to assign to this 
user or type the name of the environment in the field.

Comment
Press ESC-2 if your terminal emulator is vt100.

Comment
To view a list of environments already assigned to this user, press 
F6. Press ESC-6 if your terminal emulator is vt100.

5 Press ENTER.

System Response
Because this is a new environment for this user, Security 
Administration displays the User Function Administration screen so 
that you can assign function-level access to the user ID for this 
environment.

 (Contd)
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6 Press F2 and choose the function group.

Comment
Press ESC-2 if your terminal emulator is vt100.

7 Press ENTER.

System Response
The system displays the function group and descriptions. Note that 
these are predefined and you cannot edit them. 

8 In the Access column, enter the access code you want to assign 
this user or press a function key to assign the same access to all 
the functions.

Comment
The valid access codes are:

◗ N=No access
◗ F=Full access

9 Press F10. 

System Response
Security Administration refreshes the screen so you can choose 
and set up the next function group assignments. 

10 Do you want to set up another function group assignment?

◗ If YES, GO TO Step 6.
◗ If NO, press ESC twice to return to the User Environment 

Administration screen. The system retains the user ID.

Comment
Press ESC-0 if your terminal emulator is vt100.

 (Contd)
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Starting Sterling 
Gentran:Server Processes0

How to Start Sterling Gentran:Server on the Host

Introduction You must start processes on the UNIX host in order to test the connection of the 
client to the EDI installations and verify that the Sterling Gentran:Server 
environment is set up correctly. This topic describes the procedure you must 
perform to correctly start the processes that control your Sterling Gentran:Server 
installation.

Starting
processes

Use this procedure to start processes on the host computer. 

CAUTION
The installation process for Sterling Gentran:Server turns off the s-
bit (also known as the “set-userID/set-group-ID” bit). If your 
environment normally turns on the s-bit, it must be restored before 
you start the Sterling Gentran:Server processes. 

WARNING
Make sure that you are logged into the host as the owner of the 
environment for which you want to start the processes.

Step Action

1 If you have not already done so, log on as the owner of the 
environment whose processes you want to start.

2 Change directory to the root of the host environment.

3 Type the command ps -ef | grep ltb_server at the UNIX 
command line to check whether the broker process is running 
on the host.

4 Is the broker running on the host?

◗ If YES, GO TO Step 6.
◗ If NO, login as owner of security and enter the following 

command to start the broker process.

$SADMIN_ROOT/broker/startnb.sh
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5 Is the Korn shell in use?

◗ If YES, continue with next step.
◗ If NO, enter the following command to start the Korn shell.

ksh -m

6 Type the following commands as owner of the host software to 
start the mhs_server and mhp_server processes in the 
affected environment.
cd $EDI_ROOT
startrpc.sh

7 Use this table to determine your next step.

IF… THEN…

You need to create 
another Sterling 
Gentran:Server 
environment on this host

Repeat the instructions in the 
following sections:

◗ Preparing for Installation
◗ Installing the Software on the 

UNIX Host
◗ Setting Up Sterling 

Gentran:Server Security
◗ Starting Sterling 

Gentran:Server Processes

You are finished creating 
environments on this host

Continue with the Setting Up 
Windows Clients chapter in this 
guide.
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Step Action
Getting Started Guide – May 2011



How to Start Sterling Gentran:Server on the Host Installing Sterling Gentran:Server On the UNIX Host1 - 56
Getting Started Guide – May 2011



-12 - 1
CHAPTER

2

Setting Up Windows Clients

Contents ◗ Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
◗ How to Install the Client Software  . . . . . . . . . . . . . . . . . . . . . . . . . . 4
◗ How to Install MDAC 2.8 Components . . . . . . . . . . . . . . . . . . . . . . 11
◗ How to Install Sterling Gentran:Server Standards  . . . . . . . . . . . . . 13
◗ How to Edit the Windows Hosts File  . . . . . . . . . . . . . . . . . . . . . . . 18
◗ How to Identify the Host to DNS . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
◗ How to Install Optional Components  . . . . . . . . . . . . . . . . . . . . . . . 20
Getting Started Guide – May 2011



Overview Setting Up Windows Clients2 - 2
Overview

Introduction This chapter explains how to set up a Sterling Gentran:Server client computer.

Before You
Begin

Use this table to determine whether you are ready to install Sterling 
Gentran:Server. 

Done Task

Install the Security Administration utility and the Sterling 
Gentran:Server host software.

Reference
See the Installing Sterling Gentran:Server On the UNIX Host 
chapter in this guide for instructions.

Use the Security Administration utility to:

◗ Set up the Sterling Gentran:Server environment.
◗ Set up the Sterling Gentran:Server users.
◗ Give each user appropriate access to the environment.

Reference
See the chapter Installing Sterling Gentran:Server On the UNIX 
Host in this guide for instructions.

Start Sterling Gentran:Server processes on the host.

Reference
See the Installing Sterling Gentran:Server On the UNIX Host 
chapter in this guide for instructions.

Complete the installation checklist. Keep the checklist with you as a 
reference throughout the procedure.
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Client setup
process

This table describes the stages in the setup process for a Sterling Gentran:Server 
client.

Stage Description

1 Install the Sterling Gentran:Server client software.

2 Install Microsoft Data Access Components.

3 Install IBM® Sterling Gentran® Standards.

4 Edit the Windows Hosts file or identify the host to DNS.

5 Install the Sterling Gentran:Server online documentation.

6 Set Trading Partnership Administration preferences.

Reference
See the Setting Preferences and Default Values section in the 
Application Integration Basics chapter of the IBM® Sterling 
Gentran:Server® for UNIX Application Integration User Guide.
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How to Install the Client Software
Use this procedure to install Sterling Gentran:Server on each client computer.

Step Action

1 Close all programs running on the client computer.

2 Insert the installation CD into the CD-ROM drive of the client computer. 

3 Did the installation program start automatically and display the Welcome dialog box?

◗ If YES, GO TO to Step 6.
◗ If NO, continue to the next step.

4 Select Run from the Start menu.

System Response
Setup displays the Run dialog box. 

5 Type the following command in the Run dialog box, then click OK:

<drive>:\setup

where <drive represents the drive letter of the CD-ROM drive

System Response
Setup displays the Welcome dialog box. 

6 Click Next to continue.

System Response
Setup displays the Registration dialog box.

7 ◗ Enter your name and company.
◗ Select Client Id
◗ Click Next.

Note
You must complete all three fields to continue.

WARNING
Use a different Client Id on each client computer. Sterling 
Gentran:Server controls access by Client Id and will not allow a second 
login of an active number. If you accidentally assign a Client Id twice, 
you must reinstall Sterling Gentran:Server on the second client and 
assign an unused Client Id.

System Response
Setup displays the Choose Destination Location dialog box.
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8 Do you want to change the directory where Sterling Gentran:Server is installed?

◗ If NO, click Next and GO TO Step 11.
◗ If YES, click Browse and continue with the next step.

WARNING
If you have an earlier version of Sterling Gentran:Server, use a different 
root directory for your Sterling Gentran:Server 6.2 software. If you 
install version 6.2 on top of a previous installation, you will lose 
existing data on the client.

9 Browse to the directory into which you want to install Sterling Gentran:Server. If the 
directory does not exist, type into the Browse box a path for Setup to create during 
installation. Click OK.

WARNING
Do not use spaces in the path you specify. 

System Response

IF the directory… THEN…

Already contains a copy of Sterling 
Gentran:Server

Setup prompts you to confirm that you 
want to install into this directory and 
overwrite the existing files. 

Click Yes and GO TO Step 14.

Does not yet exist Setup prompts you to confirm that you 
want to create this directory.

GO TO Step 10.

Exists, but does not contain a copy of 
Sterling Gentran:Server

Setup displays the Select Program 
Folder dialog box.

GO TO Step 15.

10 Confirm that you want to create the directory.

System Response
The Destination Folder field displays the selected location.
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11 Click Next to accept the destination folder.

System Response
Use this table to determine the system response.

IF the directory… THEN…

Already contains a copy of Sterling 
Gentran:Server

Setup prompts you to confirm that you 
want to install into this directory. 

Continue with Step 15.

Does not yet exist Setup prompts you to confirm that you 
want to create this directory.

Continue with Step 12.

Exists, but does not contain a copy of 
Sterling Gentran:Server

Setup displays the Select Program 
Folder dialog box.

GO TO Step 15.

12 Click Yes to continue.

13 Click Next to accept the destination.

System Response
Setup displays the Select Program Folder dialog box.

14 Do you want to change the Program Folder to which Setup will add program icons?

◗ If NO, click Next.
◗ If YES, type a new folder name or select one from the existing Folders list and 

click Next.

System Response
Setup displays the Sub-Directory Name prompt.
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15 Do you want to accept the default sub-directory names?

◗ If YES, click Yes and GO TO Step 18.

System Response
Setup displays the Add IP Address dialog box.

◗ If NO, click No to display the Installation Sub-Directories dialog box and continue 
with the next step.

16 Enter the Report, HelpFiles, and LocalTemp sub-directories to which you are installing 
the Sterling Gentran:Server files. 

When you are finished, click Next to accept your changes.

WARNING
Do not use spaces in the paths you specify. 

Example

Note
All other subdirectories reside on the UNIX host and therefore cannot be changed in 
this process.

System Response
Setup displays the Add IP Address dialog box.

 (Contd)
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17 Does the displayed list of UNIX hosts contain the IP address of the host that is 
running NAMEBROKER (ltb_server)?

◗ If YES, click Next and GO TO Step 20.

System Response
Setup displays the Namebroker dialog box.

◗ If NO, click Add, click Next, and then continue with the next step.

System Response
Setup displays a dialog box to add an IP address.

18 Type the missing address into the Server IP Address field, then press Tab to move 
the curser to the Host Name field.

19 Type the system name for the host into the Hostname field, then click Add.

System Response
Setup displays the Namebroker dialog box.

20 Double-click on the IP address and name of the host that is running NAMEBROKER 
(ltb_server) through which you want the user to log on to Sterling Gentran:Server. 

Comment
This selection should match the name and address you entered on the checklist for 
the NAMEBROKER.

System Response
Setup displays the selected host information in the Namebroker field.

21 Click Next to continue.

System Response
Setup displays the Check Setup information dialog box.

 (Contd)
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22 Are the displayed current settings correct?

◗ If YES, click Next to continue.
◗ If NO, click Back until you find the dialog you must change. Make your changes, 

then click Next until you return to the Check Setup Information dialog box. Click 
Next to continue.

System Response
Setup displays progress information as it installs the software. 

WARNING
The Setup script displays warning messages if it cannot copy one or 
more Sterling Gentran:Server files to the destination. Write down each 
message before you click OK to dismiss it.

23 Did the Setup program display any warning messages during the installation 
process?

◗ If YES, click Exit and continue to the next step.
◗ If NO, Setup displays the View Readme File dialog box. GO TO Step 25.

24 Are any programs running on the client other than the Sterling Gentran:Server Setup 
program?

◗ If YES, then close those programs and return to Step 4. 
◗ If NO, call IBM Customer Support with a list of the warning messages.

25 Do you want to install Microsoft Data Access Components (MDAC)?

◗ If YES, GO TO the topic How to Install MDAC 2.8 Components in this chapter.
◗ If NO, clear the checkbox and continue to the next step.

Note
You must have MDAC to use the IBM® Sterling Gentran:Server® EDI Standards 
database. The minimum version required is 2.1sp1a. This MDAC installation process 
installs version 2.8.

26 Click Finish.

System Response
Setup finishes copying files to your computer and displays restart options.

27 Do you want to let Setup restart the client computer now?

◗ If YES, click Yes, I want to restart my computer now and remove any disks 
from the client disk drive.

◗ If NO, click No, I will restart my computer later.

28 Click Finish to complete setup.
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How to Install MDAC 2.8 Components

Introduction To read the EDI standards provided with IBM® Sterling Gentran:Server® for 
UNIX, you must have Microsoft Data Access Components (MDAC) 2.1sp1a or 
higher installed on each PC or client. MDAC include ActiveX® Data Objects 
(ADO), and OLE DB. 

If you do not already have MDAC on the client, you must install it before you install 
the EDI standards. This topic explains how to install MDAC.

Installing MDAC Use this procedure to install MDAC 2.8 on a client. 

Step Action

1 Use this table to determine your first action.

IF you are … THEN…

Continuing from the client 
setup program

Leave the I would like to install 
Microsoft MDAC 2.8 check box 
selected on the Setup Complete 
dialog box. Click Finish and GO 
TO Step 5.

Installing MDAC after 
exiting the client setup 
program

Continue with Step 2.

2 Insert the installation CD into the CD-ROM drive of the client 
computer. 

3 Select Run from the Windows Start menu.

System Response
Windows displays the Run dialog box.
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4 Type the following command in the Run dialog box and click 
OK.

<drive>:\mdac_typ.exe

where <drive> is your CD-ROM drive.

System Response
Your system loads the Microsoft Data Access Components 2.6 
Setup program and displays the Microsoft Data Access 
Components 2.6 Setup dialog box. 

5 Select the checkbox on the End User License Agreement of the 
Microsoft Data Access Components 2.6 Setup dialog box to 
accept the terms of the licensing agreement; then click Next.

System Response
Setup displays the Microsoft Data Access Components 2.6 
Setup dialog box.

6 Click Next.

7 Click Finish.

8 Click Close.

System Response
Setup displays the Sterling Gentran:Server Setup complete 
dialog box, which asks whether you want to reboot the client 
now or later.

9 Do you want to restart the client now?

◗ If YES, click Yes. Remove any disks from the client disk 
drives.

◗ If NO, click No. 

10 Click Finish to complete setup.
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How to Install Sterling Gentran:Server Standards

System
requirements

The amount of hard disk space required to use the Sterling Gentran:Server EDI 
Standards database depends on the following:

◗ New install (run from EDI Standards CD)
Approximately 10 MB of hard disk space to install the EDI Standards 
database to run from the CD.

◗ New install (install on hard drive)
Approximately 300 MB of hard disk space to install the EDI Standards 
database to run from your hard drive.

Note
For a 64 bit client installation, the odbc32.exe must be run after EDI Standards CD 
is installed, to register the standards DB.

Before you begin You must install Microsoft Data Access Components (MDAC) 2.1sp1a or higher 
before you install Sterling Gentran:Server EDI Standards. 

Caution
Install Sterling Gentran:Server before you install the EDI Standards database.

Note
If you have already set up this machine to run EDI standards from the CD-ROM 
drive, you only have to exchange the old standards CD for the most current 
Standards CD. You do not have to complete the installation procedure below.

Updated
versions
included

Please refer to the readme.txt file provided on the Sterling Gentran:Server 
Standards CD for the most current information about the standards. 

For fast access, install the Sterling Gentran:Server EDI Standards database on 
your hard drive. This requires approximately 10 MB of free space for the 
temporary installation files and 300 MB for the EDI Standards database. You can 
also access the Sterling Gentran:Server Standards database directly from the CD-
ROM.

The Sterling Gentran:Server EDI Standards database is updated periodically, 
produced on CD-ROM separate from products, and available at your request 
(usually on a quarterly basis).
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Additional
standards

included

The Standard CD also contains folders for NCPDP and VDA standard templates. 
See the IBM® Sterling Gentran:Server® for UNIX HIPAA Compliance and 
NCPDP User Guide and the IBM® Sterling Gentran:Server® for UNIX VDA User 
Guide for instructions on how to copy the templates.
Getting Started Guide – May 2011



Setting Up Windows Clients How to Install Sterling Gentran:Server Standards 2 - 15
Installing the
Standards
Database

Complete the following steps to install the EDI Standards database:

Step Action

1 Close all programs on your computer.

2 Insert the Sterling Gentran:Server Standards CD into your CD-
ROM drive.

3 Select Run from the Start menu.

4 Type <drive>:\I386\setup.exe

Where: <drive> is your CD-ROM drive (for example, D:\ or E:\)

System Response
Setup prepares the wizard that guides you through the install 
program. This may take several seconds. When the wizard is 
ready, the system displays the Welcome dialog box.
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5 Click Next> to continue the Setup program.

System Response
Setup displays the Install Standards dialog box.

6 Use the following table to determine your next action.

IF you 
select… THEN… AND…

Install to run 
from the CD-
ROM

Click Next> to install 
the EDI Standards 
database.

Proceed with Step 7.

Install to run 
without CD-
ROM

Click Next> to install 
the EDI Standards 
database.

System 
Response
The system displays 
the Standards 
Destination dialog 
box.

Type the destination or click 
Browse and select where 
you want the EDI Standards 
database to be stored. 
Proceed with Step 7.

Note
At least 300 MB must be 
available. If there is 
insufficient space available 
on the drive you specified, 
you will be prompted to 
select another location or 
increase the amount of 
space available in the target 
directory.

 (Contd)
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7 Use the table to determine your next step.

IF you… THEN…

Accept the default Click Next

Specify a new data 
source name

Type the name in the field and the Click 
Next.

System Response
The system displays the prompt: Setup is ready to install Sterling 
Gentran:Server Standards. Would you like to proceed?

8 Click Yes to install Sterling Gentran:Server Standards.

Note
If you receive messages that a .DLL is currently in use, click Ignore 
to continue the installation. You receive these messages when a 
service (like the SQL Executive service) is running in the 
background. The system will still install the EDI Standards 
database correctly.

System Response
Setup displays a message indicating that the EDI Standards 
database installation is complete.

9 Click OK.
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How to Edit the Windows Hosts File

Introduction This topic explains how to edit a Windows hosts file to specify the broker process 
(NAMEBROKER) after you have finished running Setup.

WARNING
Perform this procedure only if Setup did not add a NAMEBROKER 
entry in the hosts file. 

Procedure Use this procedure to identify the namebroker by adding it to the Windows hosts 
file.

Step Action

1 Open the hosts or host.sam file using any text editor.

Note
hosts are located in the following directory:

C:\Windows\System32\drivers\etc

Comment
If the hosts file does not exist, look for the file hosts.sam. Save 
the edited file as both hosts, and hosts.sam. 

2 Type the IP address and host name of the server on which the 
Sterling Gentran:Server host program was installed. Use the 
following format:

<IPaddress> <hostname> NAMEBROKER

Note
Separate the fields with spaces or tabs.

3 Save and close the updated hosts file.

Note

You must reboot the computer to activate this change.
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How to Identify the Host to DNS

Introduction The network at your installation must be able to identify the host that is running 
the broker process. 

Many networks use the Windows hosts file to determine the IP addresses and 
host names of all host computers. Setup allows you to add addresses and names 
to the hosts file. 

There are several ways in which you can identify the host that is running the 
broker process. This topic describes one way–by adding the name of the host 
running the Sterling Gentran:Server broker process to Domain Name Services 
(DNS). This method assumes that you have the NAMEBROKER environment 
variable set. You do not have to use this method if you prefer to use another.

Note
The DNS ignores the hosts file. Instead, it uses environment variables such as 
those set in the autoexec.bat file. 

Procedure Use this procedure to add the broker process to the client computer autoexec.bat 
file. This will allow the DNS to identify the Sterling Gentran:Server host.

Step Action

1 Open the autoexec.bat file in a DOS text editor.

2 Set the NAMEBROKER environment variable to the name of the 
UNIX host on which you will run Sterling Gentran:Server. 

Example
set NAMEBROKER=<machine name>

Where

<machine name> is the system name for the UNIX host. Your 
system administrator can provide this information.

3 Save your changes to the autoexec.bat file.

4 Reboot the client computer to apply the changes.
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How to Install Optional Components

XML translation
option

See the How to Load and Install the XML Translation Option topic for instructions 
on installing the XML translation option on the host.
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Overview 0

Introduction

The
Communications

Toolkit

The Communications Toolkit enables Sterling Gentran:Server to use Cleo A+® or 
Cleo 3780Plus® communication software to access a Value-Added Network 
(VAN). 

Among other services, VANs provide store-and-forward messaging in a dial-on-
demand environment. This means that the VAN stores files in a mailbox until the 
recipient to whom they are addressed dials into the VAN and picks them up. 

When to use the
Communications

Toolkit

Use the Communications Toolkit if you connect to the Commerce Net®, 
Advantis®, or GEIS® networks, and you use or plan to use either Cleo A+ or Cleo 
3780Plus.

What do I need
to buy?

The Communications Toolkit is included with IBM® Sterling Gentran:Server® for 
UNIX - Workstation and IBM® Sterling Gentran:Server® for UNIX. 

However, Cleo A+ and Cleo 3780Plus are not part of the Sterling Gentran:Server 
product; you must purchase Interface Systems’ Cleo A+ or Cleo 3780Plus 
communication software. 

How to activate
the

Communications
Toolkit

To activate the toolkit functions, you need to configure the Communications Toolkit 
and then install the Cleo software.

Communications Toolkits files are included in the Sterling Gentran:Server host CD 
and are installed automatically with the Sterling Gentran:Server host software.

In this chapter This chapter provides instructions for setting up the toolkit.
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What Is the Communications Toolkit?

Command
scripts

IBM provides command scripts for the third-party communication packages, Cleo 
3780Plus and Cleo A+. The scripts control the processes of:

◗ Dialing the VAN
◗ Logging in
◗ Transmitting waiting files
◗ Receiving any files waiting on the VAN
◗ Logging off 
◗ Exiting

Supported VANs This table describes the VANs and protocols supported by the Communications 
Toolkit.

Toolkit parts There are two primary parts to the Communications Toolkit provided with Sterling 
Gentran:Server:

◗ Cleo A+ scripts and configuration files
◗ Cleo 3780Plus scripts and configuration files

Cleo software Cleo A+

Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including ASCII, Xmodem, Ymodem, 

VAN Supported Protocols

IBM® Sterling Information Broker®

(IBM)

Asynchronous-ASCII

Bisynchronous

Advantis 

(IBM)

Asynchronous-Xmodem

Bisynchronous

GEIS 

(General Electric Information System)

Asynchronous-Xmodem

Bisynchronous
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Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo 3780Plus

Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCDIC data for transmission and EBCIDIC data to ASCII data upon receipt of 
the EBCDIC data.

WARNING
The scripts in the Communications Toolkit expect to find the Cleo 
software in a specific directory relative to the Sterling Gentran:Server 
directories. To prevent complications, install the Cleo software after 
you install and set up Sterling Gentran:Server and the 
Communications Toolkit.
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COMM Subdirectory Structure

Diagram The following diagram illustrates the directory structure required by the 
Communications Toolkit. Installation of Sterling Gentran:Server automatically 
installs the Communications Toolkit files for you.

Location of
communication

scripts and
configuration

files

The Cleo communications script and configuration files reside in subdirectories of 
the COMM CleoA or CleoB subdirectory of the Server directory.  

Directory Contents

Server/COMM/CleoA 

                 (A+)

Holds Cleo A+ asynchronous package

Server/COMM/CleoB

            (3780Plus)

Holds Cleo 3780Plus bisynchronous package
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VAN
subdirectories

Under the CleoA and CleoB subdirectories, each VAN has its own subdirectory:

◗ cnet for Sterling Information Broker
◗ adv for Advantis
◗ geis for GEIS.

Subdirectory
contents

The adv, cnet, and geis subdirectories contain files that enable the 
communications application to communicate with the corresponding VAN.

You should use the subdirectory appropriate to your network to hold the outbound 
file <van>s that you are transmitting to the VAN. 

Note
You should place files you are sending in the communications subdirectory before 
a session. For example, to send a file to Advantis via an asynchronous 
communication session, place the file in Server/COMM/CleoA/adv/advs.

During a session, the system places the inbound file <van>r.000 in the 
communication subdirectory. This file contains any files received during a 
communications session. 

Important files This table lists the important files that the Communications Toolkit uses or creates. 

Filename Description

<van>.cfg A configuration file specific to the VAN indicated in the 
file name.

edilog.fil A log file produced by each bisynchronous Advantis 
session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

advmsg.fil A file containing messages produced by each 
bisynchronous Advantis session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.
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<van>*.job Cleo job file for connecting to the supported networks. 
The individual files connect as follows:

◗ cnetsr.job - Sterling Information Broker via the 
CompuServe network local access nodes.

◗ advsr.job - IBM Advantis network
◗ geissr.job - GEIS network

<van>.log A log file specific to the last connection made to the 
indicated VAN.

<van>.mon A monitor file specific to the last connection made to 
the indicated VAN.

<van>.ovr A data translation file that provide protocol transfer 
information that Cleo requires.

cnet.rpts A file containing Sterling Information Broker reports. 

<van>s The user data file to be sent to the network. Must be 
placed in the directory for the specific VAN before 
connecting to the VAN. 

WARNING
You must move or delete this file after 
completing the session successfully. 

Sterling Gentran:Server will send a duplicate 
transmission unless this file is overwritten or 
deleted before the next session.

Sterling Gentran:Server may overwrite the file 
if you do not move it before the next session. 
The file will then be unavailable to retransmit 
data.

 (Contd)
Filename Description
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<van>r.nnn The user data file that Sterling Gentran:Server receives 
from the VAN. The first file received has an extension 
of .000. If the file is moved from the VAN directory 
before another file arrives, the next file received also 
has an extension of .000.

WARNING
The file extension is incremented by one with 
the receipt of each new file unless the prior 
version is moved or deleted before the 
session. If your site uses automated file 
processing, it may not recognize the 
incremented file. 

geisrpt.* A session log report generated by GEIS under 
3780Plus or AllSync.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

 (Contd)
Filename Description
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The Communications Toolkit Setup Process

Process flow This diagram shows the flow of the setup process required to prepare the 
Communications Toolkit to work with Sterling Gentran:Server.

Set Up 
Communications

Toolkit

Install Cleo 
Communications

Software

Install
Sterling Gentran:Server
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Procedures 0

How to Set Up Asynchronous Communications

Introduction This topic contains the procedures for setting up asynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Microcom
Network

Protocol (MNP)

The Microcom Network Protocol (MNP) enables error correction during 
transmissions. It is particularly important when connecting to Sterling Information 
Broker. 

Modifying the
VAN

configuration file

Your Cleo A+ VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains all or 
most of the required network configurations. However, you may have hardware 
issues that require you to modify the file.

This table lists the environment parameters you may need to modify. The 
Parameter column lists the name of the parameter and the related file.

Parameter Description

Modem 
Initialization 

(modeminit.cfg)

This parameter normally contains the async factory 
default setting for your modem. To use another setting, 
check the AT commands in your modem user guide. 
Usually, the setting & F0 sets up most asynchronous 
modems in standard asynchronous mode. 

Port

(device.cfg)

This is the port to which the modem is installed. 

◗ If you use DOS or Windows, you may use COM2 or 
a similar setting.

◗ If you use UNIX, you may use /dev/ttyp3 or a similar 
setting.

Port Speed

(speed.cfg)

This parameter identifies to Cleo the baud rate of the port 
so that Cleo knows how fast to write to the port. This is 
NOT the dial-up connection speed or the modem baud 
rate.
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Terminal Type

(terminal.cfg)

The terminal type is usually VT100 or VT220, depending 
on the terminal type to be emulated. Refer to the Cleo 
documentation for more information.

Dial Initialization This is the most important configuration parameter. It is 
used to set the unique configuration that a particular VAN 
expects. Use the following table to guide you in setting 
this parameter.

VAN Dial-Initialization Settings

Sterling
Information
Broker

◗ MNP error correction protocol
◗ Software Flow Control (also known 

as XON/XOFF Flow Control)

Advantis ◗ MNP error correction protocol
◗ Hardware Flow Control (RTS/CTS)
◗ FTP: Xmodem (in addition to the 

MNP protocol)

GEIS ◗ Either Hardware Flow Control 
(RTS/CTS) or Software Flow 
Control

CAUTION
If you use Software Flow Control, 
make sure the Dial Init and 
FLOWCONTROL setting in the 
configuration file are compatible.
◗ FTP: Xmodem

 (Contd)
Parameter Description
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How to Set Up Bisynchronous Communications

Introduction This topic contains the procedure for setting up bisynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Editing the
configuration file

Your Cleo 3780Plus VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains 
all or most of the required network configurations. However, you may have 
hardware issues that require you to modify the file.

The parameter settings that sometimes need to be increased are:

◗ Wait Limit
◗ Retransmission Limit

Important
The configuration file does not contain any labels. Consult the Cleo 
documentation to determine which lines to edit within the file.

Use this procedure to edit the configuration file for Sterling Information Broker, 
Advantis, and GEIS.

Step Action

1 Open the VAN Configuration File in a text editor.

2 Set the Wait Limit as needed.

3 Set the Retransmission limit as needed.

4 Initiate a Cleo session so you can test communications to the 
VAN. 

5 Check whether a completion status of ‘0’ was returned.

◗ If the status was 0, you are finished editing the 
configuration file.

◗ If a non-zero was returned, use the <van>.log and 
<van>.mon files to troubleshoot.

Reference
See the topic Cleo 3780Plus Troubleshooting for more 
information.
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Editing the job
file

Use this procedure to edit the job file for cnet bisync communications.

Step Action

1 Open the job file in a text editor.

2 Set the dialing command.

Example
AUTODIAL n-nnn-nnn-nnnn T60 R3

Where 

n-nnn-nnn-nnnn is the connection telephone number

T60 is the time in seconds to wait for a connection to complete

R3 is the number of times to retry a connection attempt.

Comment
We recommend that you use the default time and retry 
settings.

3 Set mailbox ID and password. You must set it in three separate 
places:

KEY $$REQ ID=xxxxxR BID=’nnnnnnn’ -x

KEY $$REQ ID=xxxxxD BID=’nnnnnnn’ -x

KEY $$ADD ID=xxxxxD BID=’nnnnnnn’ -x

Where 

xxxxx is the five character network mailbox ID

nnnnnnn is the seven digit password.

Warning
These are the only changes to the job file approved 
by IBM. Any other changes will NOT be supported by 
IBM Customer Support personnel.
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How to Start Up Cleo A+

Description Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including raw ASCII, Xmodem, Ymodem, 
Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo A+ start-up
command

The Cleo A+ start-up command consists of the command to execute the 
application A+ and several parameters. The two most important parameters are 
the job file and tokens, which are explained below.

The rest of the information that you can place in the start-up command is identified 
within the job file. A log file is generated automatically. 

.job file This parameter identifies the job file to use for the session. The job file determines 
how Cleo manages a communication session. There is a separate job file for each 
VAN which ends with the extension .job. For example, the Advantis job file is 
advsr.job. 

This table lists the job file that corresponds to each supported VAN.

VAN Async (COMM/CleoA/.) Job File

Sterling Information Broker via CompuServe .cnetsr.job

Advantis Expedite/Async .advsr.job

GEIS EDI*Express .geissr.job
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Tokens A token is a piece of information that is passed to a job, such as the VAN 
telephone number or your VAN ID. The token parameter identifies the tokens to 
be passed to the job as it is running. 

This table lists the available A+ tokens for each VAN.

VAN
Token 

Number Description

Advantis 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID.

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

Sterling 
Information 
Broker

1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 Mailbox ID. (Sxxxx)

3 Mailbox password. (nnnnnnn)

4 Mailbox Application ID obtained from network 
support. (EDIx)

5 Report slot ID. (xxx)

6 Data slot ID. (xxx)

7 Node access host. (compu)

GEIS 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Example start-up
command

A+ jobfile=./cnet/cnetsr.job “tokens=18005551212 SX999 1234567 EDIx R D mci”
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How to Start Up Cleo 3780Plus 

Description Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCIDIC data for transmission and EBCIDIC data to ASCII data upon reception of 
the EBCIDIC data.

Cleo 3780Plus
start-up

command

The Cleo 3780Plus start-up command consists of the Cleo command 3780Plus’ 
along with several other parameters. These are required parameters:

You can use the following optional parameters in the start-up command.

Note
The log is not required. However, IBM Customer Support personnel must have the 
log to assist you in troubleshooting any communication difficulties you may 
encounter. 

Parameter Description

-d Identifies the device or communications port to use this 
session.

-j Identifies the .job file to run.

VAN Bisync (COMM/CleoB/..) Job File

Sterling Information Broker .cnetsr.job

Advantis Expedite/Direct .advsr.job

GEIS EDI*Express .geissr.job

-k Used to pass the tokens to the .job file as it is running.

Parameter Description

-c Identifies the configuration file to use. The .job file includes this 
information. 

-LO Directs Cleo to generate a new log for the session if one does 
not exist in the COMM directory or overwrite an existing one. 
This command is recommended. 
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GEIS and
Advantis tokens

This table lists the available 3780Plus or AllSync tokens for GEIS and Advantis.

Note
To control startup of bisynchronous communications for Sterling Information 
Broker, you need to edit the job file instead of using tokens.

Reference
See the How to Set Up Bisynchronous Communications topic in this chapter.

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWDnnn -LO

VAN
Token 

Number Description

Advantis 1 Connection telephone number. 

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID. 

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

GEIS 1 Connection telephone number.

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Start-Up Procedure Examples

Introduction Communications is not a Sterling Gentran:Server application and the procedures 
to start communications can vary from environment to environment. Once 
communications are set up, you use the same commands to start it regardless of 
the platform.

Initiating
communications

through
automated

procedures

The communications toolkit has certain expectations regarding file placement. 
You can automate processes to move the file to and from the VAN directories. You 
can also automate the start-up process using .bat files created in DOS or 
Windows, or shell scripts created in UNIX or open systems. 

Examples The following examples show what you can implement into an automated 
communications procedure.

DOS or Windows Users
.BAT File Example

copy C:\Server\ediout?.fil C:\Server\comm\cleoa\cnet\cnets

del C:\Server\ediout?.fil

cd \Server\comm\cleoa

aplus jobfile=.\cnet\cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

copy C:Server\comm\cleoa\cnet\cnetr C:\Server\comm\cleoa\ediin?.fil

del C:\Server\comm\cleoa\cnet\cnetr

UNIX Systems Users
Shell Example

cp/Server/ediout?.fil /Server/comm/cleoa/cnet/cnets

rm/Server/ediout?.fil

cd/Server/comm/cleoa

A+ jobfile=./cnet/cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

***error recovery procedures ie; if$? =gt 0 ...****
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cp /Server/comm/cleoa/cnet/cnetr /Server/edliin?.fil

rm /Server/comm/cleoa/cnet/cnetr

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWD -LO
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Troubleshooting 0

Communications Session Error Recovery

Introduction With communications applications, failures can occur. The communications 
scripts developed by IBM are designed to handle common communications 
errors. 

Error messages
and end codes

The communications script files (<van>sr.job files), have an “error Fall Thru” 
section. This section lists the messages that the Cleo application writes to the .log 
file. Each time a session error occurs, the .job file posts a relevant error message 
to the log and returns an end code when it exits the Cleo application. You can use 
this end code in a shell script (UNIX) or .bat file (DOS/Windows) to decide 
whether communications ended successfully. An end code of 0 indicates success 
and a non-zero value indicates a failure. The various end code values indicate 
why the failure occurred. 

Sterling
Information

Broker Async
end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

Sterling Information Broker Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established.

50 Error occurred at some point during the logon process to 
the network. Connection established to communication 
node but no session established with host. 

60 Error occurred while attempting to transmit your 
outbound data to the network; resend data.

70 Error occurred while attempting to receive inbound data 
or reports from the network; any data to be sent during 
that session was NOT sent; retry may be required.
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Sterling
Information

Broker Bisync
end codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

Advantis
Expedite/Direct

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

Sterling Information Broker Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during receive process for inbound data 
or reports from the network; retry may be required.

50 Error may have occurred at some point during transmittal 
of ‘request cards’, ‘add’ card’, or outbound data file; retry 
may be required.

Advantis Expedite/Direct Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during logon process; session never 
established communication to Advantis network, even 
though connection was made. 

50 Error occurred during transmittal of outbound data to 
Advantis network.

55 Error occurred during transmittal of outbound flat file data 
to Advantis network.
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Advantis
Expedite/Direct

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

60 Error occurred during reception of inbound data from 
Advantis network; retry may be needed.

65 Although data may have been collected by 
communications, Advantis may not recognize this 
because the session failed after the data was received; 
they may send duplicate data in following session. 

70 Logoff process failed and Advantis may not have 
collected or acknowledge your receipt of data.

 (Contd)
Advantis Expedite/Direct Async (A+)

End Code Meaning

Advantis Expedite/Direct Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to Advantis network even 
though connection was made.

50 Error occurred during transmittal of data.

55 Error occurred during transmittal of ‘receive’ and ‘receive 
log’ commands occurred, or acknowledgment from 
Advantis never received. 

60 Error occurred during receive process for inbound data 
file or reports from Advantis.
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GEIS
EDI*Express

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

GEIS EDI*Express Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network, even 
though connection was made. 

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network.

65 Error occurred during reception of data from GEIS 
network.

70 Error occurred during logoff.
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GEIS
EDI*Express

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

GEIS EDI*Express Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network even 
though connection was made.

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data was never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network, or failure occurred 
receiving data from GEIS network. 

65 Error occurred during transmission of  *EOS command; 
session may not even be recorded on GEIS network 
side.
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Cleo 3780Plus Troubleshooting

Introduction This section offers possible solutions to three of the most common situations. See 
your Cleo documentation for further information.

Problem and
solution table

This table lists common problems and solutions.

Problem Possible Solution

During a RECEIVE process, 
you encounter a WAIT error.

Increase the Wait Limit parameter in the Cleo 
configuration file (cnet.cfg, adv.cfg, or geis.cfg).

During a SEND process, you 
encounter a RETRAN error.

Increase the Retransmission Limit parameter in 
the Cleo configuration file (cnet.cfg, adv.cfg, or 
geis.cfg).

At any point in the session, 
you encounter a BIDLMT 
error.

Check the documentation for your modem and 
verify that it can handle synchronous 
communications, then try again. 

If the problem continues, contact IBM Customer 
Support for information and assistance.

Note
The BIDLMT error can occur when you attempt 
to connect to a bisynchronous line at a speed 
other than that of the line. For example, if you 
attempt to connect to a 9600 bisynchronous line 
at 2400 baud. 
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Connecting to Other VANs and Directly to Trading 
Partners

Introduction If you need to connect to a trading partner directly or to a VAN that is not 
supported by the Communications Toolkit, you will need to create a Cleo 
communications script to connect to the VAN. You may also need to create a 
configuration file.

About creating
communications

scripts

Scripts are usually created as ASCII text files, which you do not need to compile.

Cleo 3780Plus The Cleo 3780Plus communications application software enables an ASCII 
system to emulate a 2780 or 3780 terminal. With 3780Plus, you can transmit and 
receive data from any system that supports the 2780 or 3780 bisynchronous 
protocols.

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires.
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Basic Cleo
3780Plus

commands

The table below lists some basic Cleo commands and descriptions. See your Cleo 
3780Plus documentation for more detailed information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system modems for a 
communications connection.

◗ tel# = The number to connect to.
◗ Txx = The timer delay for waiting for an answer 

from the remote modem.
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails.

KEY msg -ENRX Used to send a user a specified message. Often 
used to send commands such as a system logon to a 
remote system. Unless otherwise specified, Cleo 
automatically transmits an End of Transmission 
(EOT) character when the message transmission is 
complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -E = Suppress an EOT character after the 
message is transmitted.

◗ -X = Suppress an End of Text (ETX) character as 
well as an EOT character after the message is 
sent.

◗ -N = Send non-transparent data from the 
message through “as is” (no translation).

◗ -R = Suppress inter-record separators from the 
transmitted message.

TEXT path/filename -
ENRX

Used to transmit specified files to the remote system. 
The switches that follow the command (-ENRX) are 
used for protocol and translation functions. See 
descriptions above.
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Suggestions ◗ Reference the 3780Plus documentation to learn about the many other 
session script commands, startup options, and other functions not discussed 
in this appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the 3780.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

◗ There is a Monitor file you can use as a line scope to determine what is being 
transferred to and from your system. This monitor is in EBCDIC Hexadecimal 
code. There is a conversion chart in the 3780Plus documentation that may 
help you read this trace.

Cleo A+ Cleo A+ enables users to transmit and receive files from systems that support 
asynchronous file transfer protocols. You can run sessions interactively or use 
scripts you have written to perform unattended functions. Several configuration 
options are available for file transfer: ASCII, Xmodem, Ymodem, Zmodem, 
Kermit, Ansi, and FTP (slip, ppp, telnet).

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires. A+ allows 
use of environment variables, user-defined variables, and the ability to control file 
naming during a session.

RECEIVE path/filename -
NX

Used to receive files from the remote system to a 
specified path and filename. A received EOT 
character terminates the command. A received ETX 
character causes Cleo to terminate the write to the 
specified file and start writing into an incremented 
filename. Depending on the user filename, Cleo may 
overwrite the previous data in the specified file.

Switches:

◗ -X = Ignore incoming ETX characters
◗ -N = Allow transparent data to be received “as is” 

(no translation)

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this command.

 (Contd)
Command Description
Getting Started Guide – May 2011



Connecting to Other VANs and Directly to Trading Partners Setting Up Communications3 - 30
Basic Cleo A+
commands

This table includes descriptions of basic Cleo A+ commands used to start a 
dialup, send commands to a remote system, receive files, send files, and 
terminate the connection. See your CleoA+ documentation for more detailed 
information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system modems for a 
communications connection.

◗ tel# = The number to connect to
◗ Txx = The timer delay for waiting for an answer 

from the remote modem
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails

KEY msg -NTR Used to send a user a specified message. Often 
used to send commands such as a system logon to 
a remote system. Unless otherwise specified, Cleo 
automatically transmits a CR character when the 
message transmission is complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).

◗ -T= Force message through the translation 
table.

◗ -R= Suppress carriage return (CR) from the 
end of the transmitted message.

SEND path/filename / 
remote filename -TN

Used to transmit specified files to the remote 
system. The remote filename parameter is used to 
send the same filename to the remote system. The 
switches that follow the command (-TN) are used 
for translation functions.

◗ -T= Force message through the translation 
table.

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).
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Suggestions ◗ Reference the A+ documentation to learn about many other session script 
commands, startup options, and other functions not discussed in this 
appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the A+.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

Configuration
file

Depending on your trading partner requirements, you may need to create a 
configuration file. The important thing to remember is that the settings defined in 
the configuration file that pertains to your system or your modem should always 
be in sync with each other. Be sure to talk to staff at the remote site to determine 
its requirements for connection. Never assume anything will work. Even if you 
guess on how to establish the connection you will still need to determine the 
session protocol. Talk to your remote staff!

Extended
Communications

Support
Services (ECS)

If you do not have the resources required to develop the communications or 
configuration file, IBM offers consulting services to create, maintain, install, and 
test communications. Contact IBM Customer Support and ask for 
communications support for information.

RECEIVE path/filename -
NT

Used to receive files from the remote system to a 
specified path and filename. Depending on the file 
transfer type you are using, when the receive is 
complete, A+ attempts to write to the specified file 
or into an incremented filename. A+ may overwrite 
the previous data in the specified file, depending 
on the filename.

Switches:

◗ -N= Allow transparent data to be received “as 
is” (no translation).

◗ -T= Force the outbound data through the 
translation table.

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this 
command.

 (Contd)
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Introduction

Welcome Welcome to Sterling Gentran:Server, the electronic data interchange (EDI) 
software that makes it easy to manage data exchanges between you and your 
trading partners. The heart of electronic data interchange is the translation of data 
into and out of formats that are intelligible to computerized data management 
systems. 

Sterling Gentran:Server enables you to exchange data with your trading partners. 
When you send application data, Sterling Gentran:Server converts your data into 
EDI standard formats that can be understood by your trading partners. When you 
receive data in a standardized format, Sterling Gentran:Server translates the data 
into a format your application can understand.

You use Sterling Gentran:Server to describe your applications, edit standards, 
maintain trading partnership information, and generate translation “maps,” which 
are sets of instructions for translating data.

Note
If your company purchased the XML translation option, you can also exchange 
data in XML format. See the IBM® Sterling Gentran:Server® for UNIX XML User 
Guide for more information.

In this chapter This chapter contains background information about Sterling Gentran:Server that 
you should know before beginning to use the software.

Key terms This table describes key terms used in this chapter.

Term Description

application The business software generating the business 
information that you are sending or receiving 
electronically.

client The computer in a client/server network that acts as the 
interface between the user and the server.

client/server A computer network architecture in which data is stored 
and processing is performed on the server, which users 
access through the interface provided on the client. 

default A value that is automatically assigned.
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EDI Electronic Data Interchange.

Application-to-application transfer of key business 
transaction information in a standard or XML format via a 
computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of 
transaction data.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI 
document and the data fields in your application

◗ The elements in an XML document and the data 
fields in your application, EDI standard document, or 
in another XML document

◗ The segments and elements of two different 
standards

◗ The records and fields of two different applications

master directory The directory on a server that stores your master files.

master file The version of a map that Sterling Gentran:Server uses 
to process data. 

server The computer in a client/server network that performs 
the major system security, data storage, and computing 
tasks.

standard format A format intelligible to computerized data management 
systems.

temporary file A file on the client that Sterling Gentran:Server uses 
during editing and compiling.

trading partner The company, division, or group with which you are 
exchanging business data electronically.

Trading Partnership An arrangement to exchange information in a specific 
document type with a specific trading partner and using a 
particular standard version.

user directory The directory on the server that temporarily holds the 
files being transferred from a client working directory to 
the master directory on the server.

 (Contd)
Term Description
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working file A file that is stored in the user working directory on the 
client while the user has it checked out for editing.

working file directory The directory created on the client to hold the files that a 
user is editing.

 (Contd)
Term Description
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Sterling Gentran:Server Features

Introduction This summary lists the features Sterling Gentran:Server provides for your 
translation needs.

Product versions There are two basic versions of Sterling Gentran:Server:
◗ IBM® Sterling Gentran:Server® for UNIX - Workstation, which runs on a PC
◗ IBM® Sterling Gentran:Server® for UNIX, which runs on a client/server 

architecture

Sterling
Gentran:Server

for UNIX
architecture

The client/server architecture provides:
◗ An interface with a Windows look and feel.
◗ UNIX computing power for processing-intensive tasks.
◗ Multi-user capability.
◗ System and file security.
◗ Availability of optional products.

Multiple Help
sources

Sterling Gentran:Server provides Help through:
◗ Wizards to guide you through the key record-creation processes.
◗ Online Help with task-oriented content.
◗ Documentation provided on CD-ROM for online access.

Automated
functions

The following features automate many tasks for you.

Archiving
◗ Stores and retrieves both EDI and user-defined data
◗ Tracks key EDI activities; provides reports and audit trails of translations

Functional Acknowledgments
◗ Handles inbound and outbound functional acknowledgments and 

reconciliation
◗ Provides status information for each document

Task Scheduler
◗ Runs processes such as upload and download, translation, communications, 

and other tasks in a totally unattended mode
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Mappers The mapper available in Sterling Gentran:Server 6.2 is the Application Integration 
system.
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Sterling Gentran:Server for UNIX Client/Server 
Strategy

Introduction This topic describes the IBM® Sterling Gentran:Server® for UNIX client/server 
architecture.

Description A Sterling Gentran:Server installation consists of a UNIX server (host computer) 
connected by a network to one or more client PCs. The server provides data, 
security, and translation processing, while the client computers provide the user 
interface, mapping tools, and the trading partnership maintenance module. 

Advantages The client/server architecture provides the following advantages:

◗ A user interface with a Windows look and feel to allow users familiar with PCs 
to quickly learn how to use the Sterling Gentran:Server interface

◗ UNIX computing power for processing-intensive tasks such as performing 
translation, without the expense of a UNIX box for every user

◗ A true multi-user system that allows only one user to edit a file at a time, but 
also allows other users view-only access to locked files

◗ Increased system and file security.

Architecture This illustration and accompanying table show the major components of the 
Sterling Gentran:Server client/server architecture.

Server
 Client

(UNIX)
(Windows)

Communications
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Where
components

reside

This table shows which Sterling Gentran:Server components reside on the server 
and which on the client.

Environments Environments are installations of the Sterling Gentran:Server software on the 
UNIX server. Usually, each installation is dedicated to a certain purpose. They are 
physically represented as branches in the directory tree structure and can be 
created for many purposes. They can be especially useful for providing a place to 
test changes without affecting normal activity.

Examples
Some examples of environments created for specific purposes follow.

Installations based on the activity performed: 
◗ Development
◗ Testing
◗ Production

Installations based on the document generated: 
◗ Purchase orders
◗ Invoices

Installations based on the industry of the trading partner: 
◗ Automotive
◗ Aerospace
◗ Medical

Server Client Server or Client

Programs ◗ Translator
◗ Archiver
◗ Security
◗ Utilities

◗ Mapper 
(Application 
Integration 
system) editors

◗ Compiler
◗ Archive viewer
◗ Trading partner 

maintenance

Data ◗ Maps and 
translation 
objects

◗ Trading partner 
records and 
associated files

◗ Temporary files ◗ Standard files 
(Application 
Integration 
system)
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Security Within each installation, the system administrator can assign different levels of 
access to a user for each of the major functions within Sterling Gentran:Server.

Levels of access
This table describes the different levels of access.

Example
By creating separate environments (installations) and assigning appropriate 
permissions, system administrators can assign users access appropriate to the 
work they perform. For example, a system administrator might have Full Access 
permission in all environments, while a user whose job is to process reports may 
have only View permission in the production environment and No Access 
permissions in all other environments.

Functional areas
This table shows the basic functional areas and types of access that the system 
administrator may assign you.

Note
Each of the editors functional areas may be collectively set to one of three types 
of access. Each of the programs functional areas may be collectively set to one of 
two types of access.

Level of Access Description

Full Access Gives you permission to view, copy, rename, load, 
unload, and edit files.

View Gives you permission to view files, but not to alter 
them.

No Access Prevents you from using an editor, viewing files, or 
running a program.

Functional Area Types of Access

Editors Archive Retrieval Full Access

View-only

No Access

File Browser

Trading Partner Preferences 
Settings

Trading Partner Editor
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Programs Process Control Manager Full Access

No AccessArchive load/unload/create/
purge

TP/org/category/contact load/
unload/create

Run Program: D-ISAM File 
Operations

Server Workbench

Schedule Tasks to Run 
Automatically

Run Tools

Run Inbound and Outbound 
Translation

 (Contd)
Functional Area Types of Access
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Running Multiple Sessions

Definition A session is a single instance of the Sterling Gentran:Server application running 
in a window on your desktop.

Sterling Gentran:Server does not limit you to a single session; you can run more 
than one instance of IBM® Sterling Gentran:Server® for UNIX client software or 
IBM® Sterling Gentran:Server® for UNIX - Workstation at the same time. Each 
time you start Sterling Gentran:Server on your desktop, you start a new session. 
Each session runs in a different window. Running multiple sessions enables you 
to perform different Sterling Gentran:Server tasks in each window.

How many
sessions can

you run?

You can run:

◗ Up to four sessions of the IBM® Sterling Gentran:Server® for UNIX client 
software at the same time on one Windows desktop

◗ Up to four sessions of IBM® Sterling Gentran:Server® for UNIX - Workstation 
at the same time on one Windows desktop

◗ IBM® Sterling Gentran:Server® for UNIX - Workstation and IBM® Sterling 
Gentran:Server® for UNIX client software at the same time on one desktop.

Example
You run three simultaneous sessions of the IBM® Sterling Gentran:Server® for 
UNIX client software for the host1 and environment XYZ combination:

◗ Session 1, view a file with the File Browser
◗ Session 2, search for a Trading Partnership record
◗ Session 3, create a new category

Performance
limitations

Each additional session you start degrades performance. Opening too many 
sessions at once can cause the client to lock.

Login
requirements for

UNIX

When you start another Sterling Gentran:Server session for a host and 
environment that is running on your desktop, you must use the same User Name 
and Password to log onto the new session.

If you want to start a session for a different host or environment, you can use a 
different User Name and Password.
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Process and
session limits

If you open multiple sessions on your desktop, the sessions can be for the:

◗ Same host and environment (IBM® Sterling Gentran:Server® for UNIX)
◗ Same host and different environments (IBM® Sterling Gentran:Server® for 

UNIX)
◗ Different hosts and environments (IBM® Sterling Gentran:Server® for UNIX)
◗ Combination of IBM® Sterling Gentran:Server® for UNIX - Workstation 

sessions and IBM® Sterling Gentran:Server® for UNIX sessions.

This table shows the limitations on running processes in multiple sessions.

Process Limitations

File Browser None. Multiple windows permitted in each 
session.

Trading Partnership Maintenance None. Multiple windows permitted in each 
session.

Process Control Manager Once in a session for each host/
environment combination.

SAP Configuration Once in a session for each host/
environment combination. 

Standard Version Conversion Once in a session for each host/
environment combination.

Archive Once in a session for each host/
environment combination.

EC Workbench One client session for each host/
environment combination.

You can run EC Workbench multiple times 
as long as each Client session is for a 
different host/environment combination.

Translation One client session for each host/
environment.

You can run translation multiple times as 
long as each session is for a different host/
environment combination.

Map Compilation One client session at a time.

Mapping None. Multiple windows permitted in each 
session 
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If a process has session limitations and is already running, Sterling 
Gentran:Server displays a message to let you know that the process is busy and 
asks that you try again later.

File locking Sterling Gentran:Server locks certain files to prevent you from editing the same 
file in multiple sessions. If you attempt to edit a file that you are editing in another 
session, Sterling Gentran:Server displays a message to let you know that the file 
is in use.

Sterling Gentran:Server locks these files when you open them for editing:

◗ Maps
◗ Trading Partner record
◗ Group Organization record
◗ Interchange Organization record

Exceptions
Locking does not apply to:

◗ Files edited in the File Browser
◗ Trading Partnership Category files
◗ Trading Partnership Contact files

Note
If the same non-DISAM file is edited in two different parallel sessions, the last 
changes saved overwrite earlier changes from another session.

Caution
Never use the File Browser to edit an DISAM file. Doing so will corrupt the file. 

Report, log and
local temporary

files

Sterling Gentran:Server keeps the report files, log files, and local temporary files 
for each host and environment in different directories.

The system creates a directory named rpt for the report and log files under the 
directory where the Sterling Gentran:Server client software is installed. The local 
temporary working files are stored in the lcltmp directory.

For each host and environment, the system creates a subdirectory under the rpt 
and lcltmp directories. The subdirectory is named for the environment and host 
name (environment+hostname) logged in to for the session.
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Example
The Sterling Gentran:Server client software is installed in D:\gentran. The system 
creates subdirectories for the report files and for the local temporary files:

◗ D:\gentran\rpt
◗ D:\gentran\lcltmp
You start a session, logging in to the 60test environment on the host hpd350. 
Sterling Gentran:Server creates subdirectories for the session:

◗ D:\gentran\61testhpd350
◗ D:\gentran\rpt\61testhpd350
◗ D:\gentran\lcltmp\61testhpd350

Sterling Gentran:Server stores the session report and log files in 
D:\gentran\rpt\61testhpd350 and stores the session local temporary files in 
D:\gentran\lcltmp\61testhpd350.

You open a session for a different environment and host, 2XF on hpd001. Sterling 
Gentran:Server creates new subdirectories for the report and local temporary 
files:

◗ D:\gentran\2XFhpd001
◗ D:\gentran\rpt\2XFhpd001
◗ D:\gentran\lcltmp\2XFhpd001

Note
If the host or environment name contains special characters (such as *, ?, <, or >), 
the system converts the special characters to underscores (_). For example, the 
host name hp<200> is converted to hp_200_.
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Introduction

In this chapter This chapter contains general information about the Sterling Gentran:Server 
interface. It describes the menus and Toolbar of the Main Window and includes 
instructions for:

◗ Starting and exiting Sterling Gentran:Server
◗ Using menus, toolbar buttons, and dialog boxes
◗ Using the File Browser to edit text, EDI, and NCPDP files
◗ Changing your password (UNIX version only)
◗ Choosing printing properties
◗ Setting Sterling Gentran:Server preferences and default values

Key terms This table describes key terms used in this chapter.

Term Description

check box A square to the left of an option in a dialog. When the 
option is selected, the square contains an X. You click 
the check box to change whether the option is selected. 

default A value that is automatically assigned.

master directory The directory on a PC or on a server that stores your 
master files.

menu A list of related commands.

menu bar The row of menu names that runs across the top of a 
window.

option button A round button used to select one option from a mutually 
exclusive set of options.

push-button A symbol or icon that initiates some action when you 
click it.

server The computer in a client/server network that performs 
the major system security, data storage, and computing 
tasks.
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text box A box into which you enter alphanumeric text to provide 
data needed by Sterling Gentran:Server.

Toolbar A bar of buttons used to start commands.

 (Contd)
Term Description
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Starting and Exiting 0

How to Start Sterling Gentran:Server

Introduction This topic explains how to start Sterling Gentran:Server.

Note
You can run up to four sessions of Sterling Gentran:Server on the same 
desktop at once.

Starting Sterling
Gentran:Server

Follow this procedure to start and log on to Sterling Gentran:Server. 

Step Action

1 Select the Windows Start menu.

2 Select the Sterling Gentran:Server program icon from the 
Programs menu.

System Response
Sterling Gentran:Server displays the Login window. 

3 Type your user name into the User Name box.

Note
When you start another Sterling Gentran:Server session for 
the same host and environment that is running on your 
desktop, you must use the same User Name and Password 
to log onto the new session.

If you want to start a session for a different host or 
environment, use a different User Name and Password.
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Reference
See the How to Set TP Administration Preferences topic in the IBM® 
Sterling Gentran:Server® for UNIX Application Integration User Guide for 
instructions on setting Trading Partnership Administration Preferences.

4 Type your Sterling Gentran:Server user password into the 
Password box.

5 Select the host server from the Host Name drop-down list.

6 Select an environment from the Environment drop-down list.

7 Click Login.

8 Click Continue.

System Response
Sterling Gentran:Server displays the main window and logs 
you into the selected host and environment.

Note
The Main menu title bar displays the name of the host and 
environment.

 (Contd)
Step Action
Getting Started Guide – May 2011



How to Change Your Password (UNIX Version) Using Sterling Gentran:Server5 - 6
How to Change Your Password (UNIX Version)

Introduction This topic explains how to change your user password for Sterling 
Gentran:Server. 

Note
If you use IBM® Sterling Gentran:Server® for UNIX - Workstation, you do 
not have a password.

Procedure Use this procedure to change your Sterling Gentran:Server password. 

Step Action

1 Click the Start menu.

2 Select the Sterling Gentran:Server program icon from the 
Programs menu.

System Response
Sterling Gentran:Server displays the Login window. 

3 Type your user name into the User Name box.

4 Type your Sterling Gentran:Server user password into the 
Password box.

5 Select a Host Name from the drop-down list.

6 Select an environment from the Environment drop-down list.

7 Click Login.

System Response
Sterling Gentran:Server enables the Change PSW button. 
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8 Click Change PSW.

System Response
Sterling Gentran:Server displays the Change Password 
dialog box.

9 Type the new password into both the New Password and Retype 
New Password text boxes. Click OK.

System Response
The system displays the Login dialog box.

10 Click Continue.

System Response
Sterling Gentran:Server logs you in, changes your password, 
and displays the main window. 

 (Contd)
Step Action
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How to Exit Sterling Gentran:Server

Introduction This topic explains how to exit Sterling Gentran:Server.

Before you exit Any files that are checked out when you exit the application remain checked out 
and unavailable for other users to edit. Before you exit Sterling Gentran:Server, 
be sure to check in any files that you no longer need. 

Reference
See How to Check In Maps and Translation Objects and How to Check In 
File Definitions in the Working with Application Integration chapter or How to 
Check In Compiled Maps, How to Check In IG/Application Description Files 
and How to Check In Synonym and Thesaurus List Files for instructions.

Procedure Select Exit from the File menu.

Note
If you are running multiple sessions on your desktop, you must exit each 
session.

System Response
Sterling Gentran:Server logs off of the host computer and exits.
Getting Started Guide – May 2011



Using Sterling Gentran:Server Overview 5 - 9
The Sterling 
Gentran:Server User 
Interface 0

Overview

Introduction Sterling Gentran:Server features on the client use the Windows environment. To 
use Sterling Gentran:Server, you must be familiar with using a personal computer 
and with Windows functions and terminology, including the following:

◗ The terminology used to describe mouse and cursor actions; for example, 
opening, clicking, scrolling

◗ The terminology used to describe Windows-specific attributes, such as dialog 
boxes, buttons, and check boxes.

User interface The user interface for all versions of Sterling Gentran:Server includes:

◗ Screens that use the familiar Windows interface.
◗ Graphical tree organization of trading partnership records to make setup and 

maintenance easier.
◗ Graphic displays of mapping components and relationships.
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The Main Window

Introduction This topic explains the items you see on the Sterling Gentran:Server Main 
Window.

Reference
Refer to your Windows documentation for detailed explanations of Windows terms 
and functions.

Main UNIX
Window

This illustration shows an example of the Main Window for Sterling 
Gentran:Server.

Note
This illustration displays many of the options available with Sterling 
Gentran:Server. However, you will only see the options your company purchased.

Menu bar

Toolbar

Status
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Parts of the
window

This table describes the parts of the main Sterling Gentran:Server window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button description.
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Main Window Menus

Introduction You can start all Sterling Gentran:Server features and functions from the menus of 
the Sterling Gentran:Server Main Window.

UNIX Client/
Server Main

Window menus

This table describes the menus of the UNIX Client/Server Main Window.

Menu Used to…

File Menu ◗ Check in a file
◗ Check out a file
◗ Unlock a file
◗ Copy compiled maps (.tbl and .tpl) to User 

Directory on host
◗ Open the Print Setup dialog box
◗ Exit the Main Window

Edit Menu ◗ Start a mapping editor (Application 
Integration)

◗ Start the Trading Partnership 
Administration system

Translate ◗ Open the Translate Documents dialog box
◗ Generate a translation report.

Archive ◗ Set archiving parameters
◗ Open an archive
◗ Purge an archive
◗ Load and unload archived files
◗ Create new archives

XML Configuration (if you 
purchased the XML 
translation option)

◗ Open the XML Element Configuration 
window

◗ Start the XML Trading Partnership Rules 
wizard

◗ Open the XML TP Cross Reference dialog 
box.
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Application File Configuration ◗ Start the Application File Trading 
Partnership Rules wizard

◗ Open the Application File TP Cross 
Reference dialog box.

Tools ◗ Test host connection
◗ Open the Task Scheduler to schedule a 

task
◗ Run scheduled tasks
◗ Run Standard Version Conversion
◗ Start the File Browser
◗ Open the Run a Command dialog box to 

run a command line program
◗ Start optional system (such as the Process 

Control Manager or Workbench on a host) 
or an extension

Settings Specify default directories for your Sterling 
Gentran:Server files

Window ◗ Display or hide the Toolbar
◗ Display or hide the Status Bar

Help ◗ Open the Help Contents or Index
◗ Display information about using Help
◗ Display version information for Sterling 

Gentran:Server

 (Contd)
Menu Used to…
Getting Started Guide – May 2011



The Main Window Toolbar Using Sterling Gentran:Server5 - 14
The Main Window Toolbar

Introduction The Sterling Gentran:Server Toolbar consists of several buttons that you can use 
to quickly access Sterling Gentran:Server systems, tools, and optional features.

The specific buttons displayed on your toolbar depend upon the Sterling 
Gentran:Server product and options your company purchased. This topic 
describes the most common buttons. Your toolbar may include additional buttons 
for optional features.

The Main
Window Toolbar

To execute a command with a toolbar button, click the appropriate button. 

Click this… To do this…

Check in files.

Check out files.

Open the Application Integration mapping editor.

 

Open the Trading Partnership Administration system.

Open the Translate Documents dialog box or generate a 
translation report.

Start an archiving option.

 
Start the Process Control Manager system.

Open the File Browser text editor.

Display Help for the current window.
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How to Use the Sterling Gentran:Server Interface

Introduction This topic explains how to use the Sterling Gentran:Server menus, toolbars, 
dialog boxes, and other interface features.

Using the
Toolbar

To start a feature or system from the Toolbar, click the appropriate Toolbar button.

Note
For information about a Toolbar button, place the pointer on the button to display 
the button name and then refer to the Status Bar for the button function.

Using the Status
Bar

The status bar displays information, descriptions, or instructions for the active 
window, item on a dialog box, toolbar button, or command. You may see a status 
such as “Ready” for a window, an instruction such as “Enter record ID” for a text 
box on a dialog box, or “File Browser” for a Toolbar button.

To use the Status Bar, move the pointer to the window, box, or button that you 
want to check and then read the text displayed on the Status Bar.

Using dialog
boxes

You enter information within a dialog box by:

◗ Typing in text boxes
◗ Selecting items from list boxes
◗ Clicking check boxes, options, or push buttons. 

To move to the desired box or button, use either the mouse or the keyboard.

◗ When using the mouse, move the mouse pointer to the desired box or button 
and click to select the box or button.

◗ When using the keyboard, press TAB to move to the next box or button or 
press SHIFT+TAB to move to the previous box or button.

Status bar
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How to Use the On-line Help

Introduction Sterling Gentran:Server provides Help information to guide you through 
commands and procedures. Sterling Gentran:Server Help files explain many 
topics: parts of the active window, commands, dialogs, and procedures for using 
specific features to perform a task.

Getting Help You can access Help several ways. The methods available depend on the window 
you have displayed. 

Using the Help
menu

To learn how to use Help, select Using Help from the Help menu. 

The Contents command form the Help menu displays a list of Help topics that you 
can choose from. You can access Help information for the topics in different ways; 
you can use the menus at the top of the Help window, or you can use the buttons 
under the menus to search for a topic. You can print and edit Help information.

To start Help 
from… Do this…

The menu bar Select a command or topic from the Help menu. 

The toolbar Click the Help button on the toolbar for information about 
the currently displayed dialog box or window. 

Any window Press F1 for information about the window. 

A dialog box Click the Help button on the active dialog box for related 
help information. 
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Using the Help
toolbar button

On major windows, you can get window-level Help by clicking the Help button on 
the toolbar. 

Using the Help
buttons on

dialog boxes

You can get Help for any dialog box that displays the Help button. Click Help for 
more information. 

Exiting Help You can close the Help window when you are finished with it. To close Help, 
select Exit on the File menu of the Help system menu bar.

Help
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The File Browser

Introduction The File Browser is a Sterling Gentran:Server tool that enables you to open and 
edit text, EDI, and NCPDP files. It contains basic text-editing features, such as 
copying, cutting, pasting, finding, and replacing text.

When to use You can use the File Browser to open and edit:

◗ Text files, such as batch files (*.bat) and configuration files (*.cfg)
◗ EDI files
◗ NCPDP files

Note
When you open an EDI file in the File Browser, Sterling Gentran:Server runs the 
edifrmat command on the file before displaying it. The edifrmat command 
replaces the segment terminators in the file with new line terminators so that the 
format is easier to read.

CAUTION
Never use the file browser to edit a disam file. Doing so will corrupt 
the file.

The File Browser
window

This illustration shows the File Browser window.
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Parts of the File
Browser window

This table describes the parts and functions of the File Browser window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button 
description.
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How to Use the File Browser

Introduction This topic explains how to start and exit the File Browser, open a file, and use the 
File Browser editing commands to modify a file.

Starting the File
Browser

To start the File Browser, do one of the following:

◗ Click the File Browser button on the Main Window toolbar.
◗ Select Start File Browser from the Tools menu.

Opening a file There are two ways to open a file in the File Browser: from the Toolbar or from the 
File menu.

Method 1 - Toolbar button.

Step Action

1 Click the Open button on the File Browser toolbar.

System Response
The File Browser displays the Open dialog box.

2 Select Text File, EDI File, or NCPDP File to indicate the type of file 
you want to open.

CAUTION
Never use the file browser to edit a disam file. Doing so 
will corrupt the file.

3 Click OK.

System Response
The File Browser displays the standard Open dialog box.

4 Browse to the folder and file you want to open.

5 Click OK.
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Method 2 - File menu

Select Open from the File menu and then select Text, EDI, or NCPDP from the 
cascading menu.

Editing a file in
the File Browser

This table describes how to edit, print, and save a file in the File Browser.

6 IF you open… THEN the File Browser…

an EDI file displays the Enter EDI Format 
Parameter dialog box.

Continue with Step 7.

a text file displays the text file. You are 
finished. 

a NCPDP file runs the edifrmat command on 
the file you selected and 
displays the file in a newline 
terminated format.

You are finished.

7 Select the option on the Enter EDI Format Parameter dialog box to 
specify the format you want applied to the data.

System Response
The system runs the edifrmat command on the file you selected 
and displays the file in a newline terminated format.

 (Contd)
Step Action

IF you want to… Then…

Insert characters Click at the insertion point and type the 
characters.

Copy selected text to the 
clipboard

Click Copy on the Edit menu.

Paste text on the clipboard 
into the document

Click at the insertion point and then click Paste 
on the Edit menu.

Select the entire document Click Select All on the Edit menu.

Search for characters, words, 
or phrases

Click Find on the Edit menu. Then, enter the 
search string.
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Exiting the File
Browser

To close the File Browser, do one of the following:

◗ Select Exit from the File menu.
◗ Click the close button on the File Browser window.

Search for the next 
occurrence of a search item

Click Find Next on the Edit menu.

Replace selected text Click Replace on the Edit menu. Then type the 
replacement text.

Print the document Click Print on the File Menu.

Save the changes to the 
document

Click Save on the File menu.

Save a copy of the document 
under a new path or name

Click Save As on the File menu. and enter the 
new path and file name.

 (Contd)
IF you want to… Then…
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How to Change Print Properties

Introduction This topic explains how to open the Print Setup dialog box from within Sterling 
Gentran:Server. Check your Microsoft® documentation for details on how to use 
the window.

Background When you print any of the reports that Sterling Gentran:Server generates, the 
program prints the report on the default printer, using the default font style and 
size specified for that printer. You can use the Microsoft Print Setup dialog box to 
specify print properties for the default printer for the client. 

Your selections affect all printing (except printing of compiler messages) in 
Sterling Gentran:Server until you quit or change them. If you want to set these 
defaults and keep them between Sterling Gentran:Server sessions, use the 
Printers utility in the Windows Control Panel.

Opening the
Print Setup

window

Follow this procedure to open the Print Setup dialog box from within Sterling 
Gentran:Server.

Adjusting print
properties

Depending upon the font style and size, some parts of the report may not appear 
on the output (This may be a problem with fonts larger than 12 point). To correct, 
change the default font style or size. The methods of changing the default font 
style and size vary according to your PC. 

Depending upon the aspect ratio of the report, you could also try printing 
landscape instead of portrait. 

Step Action

1 Click File on either the Main, Application Integration Main, 
Application Editor, or Standard/IG Editor menu bar.

2 Click Print Setup on the File menu.
Getting Started Guide – May 2011



Overview Using Sterling Gentran:Server5 - 24
Setting Default Values 0

Overview

In this section This section explains how to set the basic directory and the Application Integration 
system preferences and default values you want your system to use.

Reference
See the Setting Preferences and Default Values section in the IBM® Sterling 
Gentran:Server® for UNIX Application Integration User Guide for information 
about setting preferences and default values for the Application Integration 
system.

Default
directories

The Set Up Directories dialog box enables you to define the default directories 
that Sterling Gentran:Server will use to store your Sterling Gentran:Server files on 
your PC or client. If you are using IBM® Sterling Gentran:Server® for UNIX, your 
system administrator will set the default directories for the server during 
installation. The server directories appear on the screen, but can’t be changed.

When to set the
values

We recommend that you set your default directory and map display values before 
you create your first map. However, you can set or change the map display 
options at any time.
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Where to go next Use this table to locate the instructions for setting particular types of preferences.

IF you want to customize… THEN select…

Client

The default directories your 
system uses to store Sterling 
Gentran:Server files

How to Change Client Default Directories

Application Integration

All the Application Integration 
system preferences

How to Set the Application Integration 
Preferences in the IBM® Sterling 
Gentran:Server® for UNIX Application 
Integration User Guide.

The list of date and time 
formats that you can use in 
map fields

How to Set the Application Date/Time Formats 
in the IBM® Sterling Gentran:Server® for 
UNIX Application Integration User Guide.

The default date format for all 
date fields used in a map

How to Set the Default Date Formats in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide.

Which map component 
descriptions are displayed

How to Customize Component Display 
Options in the IBM® Sterling Gentran:Server® 
for UNIX Application Integration User Guide.

Foreground and background 
colours of map components

How to Customize Component Colors in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide

Font type, style, or size used 
in map displays

How to Customize Global Fonts in the IBM® 
Sterling Gentran:Server® for UNIX Application 
Integration User Guide.

How map links are displayed How to Customize the Display of Links in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide.

How the map version number 
is incremented

How to Customize the Auto-increment Map 
Version in the IBM® Sterling Gentran:Server® 
for UNIX Application Integration User Guide.
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Set Up Directories Dialog Box

Introduction The Set Up Directories dialog box enables you to define the default directories 
that Sterling Gentran:Server will use to store your Sterling Gentran:Server files on 
your client.

Sterling
Gentran:Server

This illustration shows the Set Up Directories dialog box for Sterling 
Gentran:Server. Note that the Host directories are not available for editing. Your 
system administrator sets these during installation.
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Fields and
functions

This table lists the fields of the UNIX Set Up Directories dialog box and their 
functions.

Field Function

Standards Stores a list of available standards. This directory is 
located on the host.

Implementation Guide Stores implementation guides (.igs). This directory is 
located on the host.

File Definitions/Apps Stores file definitions (.ddfs). This directory is located 
on the host.

Maps Stores map files and translation objects. This 
directory is located on the host.

Trading Partner 
Records

Stores Trading Partnership files. This directory is 
located on the host.

EDI Status Audit Stores the status audit files that Sterling 
Gentran:Server generates. This directory is located 
on the host.

EDI History Audit Stores the history audit files that Sterling 
Gentran:Server generates. This directory is located 
on the host.

User Files Stores your user files. This directory is located on the 
host.

Text/Help Files Stores text files and the Sterling Gentran:Server Help 
files. This directory is located on the client.

Data Files Stores your data files. This directory is located on the 
server.

Report/Log Contains the reports and log files that Sterling 
Gentran:Server generates. This directory is located 
on the client.

Default Check In/Out Serves as the default working directory for files. This 
directory is located on the client.

Default TPL/TBL 
Location

Serves as the default working directory for translation 
objects (compiled maps). This directory is located on 
the client.

Local Temp Serves as the default working directory. This 
directory is located on the client.
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How to Change Client Default Directories

Introduction You can change the default directories for the Sterling Gentran:Server files on the 
client from the values set at installation. You cannot change the default directories 
on the host with this procedure. 

Reference
See the chapter Environment Administration in the IBM® Sterling 
Gentran:Server® for UNIX Maintenance and Troubleshooting Guide.

How to change a
directory path

Use this procedure to change a default directory path for files on the client.

Step Action

1 Click Settings on the menu bar.

2 Click Set Up Directories on the Settings menu.

System Response
The system displays the Set Up Directories dialog box, showing the 
default directories for each type of file on the client. The directories 
on the server are not active.

3 Click in the appropriate text box.
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4 Delete the current path and type the new path, or edit the existing 
path.

Note
You can use the browse button to the right of the box to browse for 
the path.

5 Click OK to save your changes.

 (Contd)
Step Action
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Overview 0

Introduction

In this chapter This chapter contains information about working in Sterling Gentran:Server and 
accessing and returning files.

Key terms This table describes the key terms used in this chapter.

Term Description

check in The act of returning a copy of a file from your 
working directory to the master directory, 
making it available to other users.

check out The act of copying a file from the master 
directory to your working directory, making the 
file unavailable to other users.

lock The act of making a file unavailable to other 
users. A file is locked once it is checked out.

unlock The act of making a file available to other 
users. A file is unlocked once it is checked in.
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Working in Sterling Gentran:Server

Background Sterling Gentran:Server uses numerous data files such as maps, translation 
objects (TPL files), file definitions, and Trading Partnership records. Sterling 
Gentran:Server installations control access to data files through environments, 
master files and working files, and through checking out and checking in master 
files.

Access rights Sterling Gentran:Server provides a security utility. A system administrator uses 
this utility to assign each user the appropriate access rights for each of the 
Sterling Gentran:Server installations (environments). Within each installation, the 
system administrator can assign different levels of access to a user for each of the 
following functional areas:

◗ Editing maps and file definitions
◗ Editing archived files 
◗ Editing Trading Partnership records and related files (contact records, 

organization records, TRADACOMS supplemental files, and category 
records)

◗ Running the translator
◗ Using the Run Program tool

This table shows the different levels of access that can be assigned to a function.

Master files Each installation contains master files.

A master file is the original, source version available to all users for viewing, and 
to one user at a time for editing.

Access Type Permissions

Full View, copy, rename, load, unload, and edit files

View View, copy, rename, load, and unload files, but not to edit 
them

No Access None
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Working files When you check out a master file to view or edit, Sterling Gentran:Server copies 
the file and transfers the working copy from the Host to your client check out 
(working files) directory.

You can check out a file to any directory on your client, but the default directory is 
the one specified in the Set Up Directories dialog box.

File checkout When you want to access a master file to edit, you must check it out. When you 
check out a file to edit, the system locks the file so that other users cannot modify 
it while you have it checked out. 

Other users with proper permissions still can view the master file or use it in a 
translation even while you are editing your working copy of the master file. 

Note 
Within the file directories, an asterisk precedes the name of any file that is 
currently checked out. This means it is locked. Even if you have Full Access, you 
can only open the file for viewing. 
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Checking in Before any other user can edit a file that you have checked out, you must check 
the file in.

When you check in a file, Sterling Gentran:Server transfers a copy of the file from 
your client PC to the user directory on the Host. When the transfer is complete, 
Sterling Gentran:Server:

◗ copies the file from the Host user directory to the Host master directory
◗ removes the copy from the Host user directory.

When you check in a file, Sterling Gentran:Server lets you choose to keep or 
remove the copy of the file on your PC. 
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Illustration This illustration shows how file access can be controlled under Sterling 
Gentran:Server. 

Environment

Master
Files

Client PCs

User A

User B

Map1 checked out

Map1 view only

Server

*Map1
*Map2

Map2 view only

Map2 checked out

Map3

Working
Directory

Working
Directory

User

Master
Directory

Directory
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Dialog Boxes 0

Select Map and File Definitions Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Check out
◗ Select File Definition Files to Check out

Purpose The Select <filename> to Check out dialog box is used to move a copy of a file 
from the master directory to a working directory on the PC. Maps, and their 
associated TPL files, and file definitions files can be checked out.

Example check
out dialog box

The same dialog box format is used to check out file definition files.

This illustration shows the Select Map Files to Check out dialog box.
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Fields and
functions

This table lists the fields of the Select Map Files to Check Out and Select File 
Definition Files to Check out dialog box and their functions.

Field Function

 …files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which Sterling 
Gentran:Server copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode Checks out the files so that you can view them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory.

Note
This button is not available in IBM® Sterling 
Gentran:Server® for UNIX - Workstation.
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:

◗ map files 
◗ associated TPL files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a different 
directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which Sterling 
Gentran:Server copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.

Next Flags the maps to be checked in and displays the 
Select TBL/TPL Files to Check In dialog box. 
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the translation 
objects (compiled maps) you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Finish Saves your changes and checks in the maps and 
translation objects you selected.
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Select File Definition to Check in Dialog Box

Introduction The Select File Definition Files to Check in dialog box is used to move a working 
copy of a file definition file (DDF) from your working directory to the master 
directory for file definitions.

Illustration This illustration shows the Select File Definition Files to Check in dialog box.
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Fields and
functions

This table lists the fields of the Select File Definitions to Check in dialog box and 
their functions.

Field Function

File Definition files 
from

Displays the name of the working directory.

The list below the name displays the names of the file 
definition files in the working directory. An asterisk next 
to a name indicates that the file is currently checked 
out.

Note
You can use the browse button to select a different 
directory.

Check in File 
Definition files to

Displays the name of the master directory for file 
definition files. This is the directory to which Sterling 
Gentran:Server copies the file.

The list below the directory name displays the names 
of the file definition files in the master directory.

Add Adds the name of the selected file definition file to the 
list of file definition files in the master directory.

Remove Removes the name of the file definition file from the 
master directory check in list.

Add All Adds the names of all the file definition files in the 
working directory to the master directory.

Remove All Removes the names of all the file definition files from 
the master directory check in list.

Check in and Remove Saves your changes, starts moving the file definition 
files, and deletes the working copies from the working 
directory.

Check in and not 
Remove

Saves your changes, starts moving the file definition 
files, and retains the working copies in the working 
directory.
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Select Map and File Definition Files to Unlock Dialog 
Box 

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Unlock
◗ Select File Definition Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you 
do not want to save changes to a file in your working directory. The following files 
can be unlocked:

◗ map files
◗ file definitions files

Example unlock
dialog box

The same dialog box format is used to unlock file definition files.

This illustration shows the Select Map Files to Unlock dialog box.
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Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

…files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which Sterling Gentran:Server 
copies the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of files in 
the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list.

Unlock Unlocks the file or files you have selected
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Procedures 0

How to Check Out and View Maps and File Definitions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file

When you check out a file, Sterling Gentran:Server transfers a copy of the file 
from the Host to the client PC working directory. If you have Full Access 
permission, Sterling Gentran:Server locks the file on the host so that other uses 
cannot edit it. If you have View privileges, Sterling Gentran:Server does not lock 
the file.

You can check out a file to any directory. The default directory is the one specified 
in the Setup Directories dialog box.

If Sterling Gentran:Server locks the file when you check it out, other users cannot 
check it out to edit it. You must check in the file to release the lock so that another 
user can access it.
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Checking out
and viewing

maps

Use this procedure to check out a map. 

Step Action

1 Open the Sterling Gentran:Server Main window.

2 Select Check Out from the File menu and then click Map.

System Response
The system displays the Select Map Files to Check Out dialog box.

Note
An asterisk preceding a file name means that the file is checked 
out. Even if you have Full access, you can only open the file for 
viewing.

3 Use this table to determine your next step.

IF you want to check out … THEN…

a map Select the map you want to check 
out from the list and click Add.

Repeat this step for each 
additional map you want to check 
out.

all the available maps Click Add All.
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4 Do you want to edit the files you are checking out?

◗ If YES, click Edit Mode. (This locks the master files.)
◗ If NO, click View Mode.

System Response
Sterling Gentran:Server displays the Checkout Files Status dialog 
box. This dialog box lists the files to be checked out and the status 
of the process.

5 Do you want to print the information displayed on the Check-out 
Map File Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Checking out a
file definition

Use this procedure to check out a file definitionfile. 

Step Action

1 Open the Sterling Gentran:Server Main window.

2 Select Check out from the File menu and then click File Definition.

System Response
The system displays the Select File Definition Files to Check out 
dialog box.

Note
An asterisk preceding a file name means the file is checked out.

3 Use the following table to determine your next step.

IF you want to check out… THEN…

a single file definition file Select the file definition file you 
want to check out from the left pane, 
then click Add.

Repeat this step for each additional 
file you want to check out.

all the available file definition  
files

Click Add All.

4 Do you want to edit the files you are checking out?

◗ If YES, click Edit Mode to move a copy of the file to your 
working directory (This locks the master files).

◗ If NO, click View Mode.
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How to Save Changes to Working Files

Introduction If a an Application Integration system map file is open, you can save changes on 
the PC:

◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have modified, 
see How to Check In Maps and Translation Objects  in this chapter.

WARNING
For example, if you are creating a new map in the Application 
Integration system using the XXX.vmp as a guide, then save the new 
map using the file name XXY.map or XXXa.map.
Sterling Gentran:Server does not recognize map extensions. When 
you check in a working map to the master directory, it overwrites any 
existing map file that has the same file name, regardless of the 
extension.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
Sterling Gentran:Server updates the file.
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Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
Sterling Gentran:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can save it 
under a new file name.

Reference
See How to Check In Maps and Translation Objects in this chapter 
to replace a master map file with a modified working copy.

3 Click OK.

System Response
Sterling Gentran:Server saves a copy of the map under the new 
name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the Sterling Gentran:Server Unlock function to remove the lock from the master 
file and delete the working copy of the file. This procedure explains how to use the 
Unlock function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.

Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ File Definition File

System Response
Sterling Gentran:Server displays the Select <filename> Files to 
Unlock dialog box.
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2 Use this table to determine your next step.

IF you want to unlock… THEN…

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
Sterling Gentran:Server moves the 
selected file to the selected files to 
unlock list.

all the available files Click Add All.

System Response
Sterling Gentran:Server moves all the 
files to the selected files to unlock list.

3 Click Unlock.

System Response
Sterling Gentran:Server displays this dialog box.

 (Contd)
Step Action
Getting Started Guide – May 2011



How to Unlock Master Files and Delete Working Copies Working with Application Integration6 - 24
2 Use this table to determine your next step.

IF you want to unlock… THEN…

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
Sterling Gentran:Server moves the 
selected file to the selected files to 
unlock list.

all the available files Click Add All.

System Response
Sterling Gentran:Server moves all the 
files to the selected files to unlock list.

3 Click Unlock.

System Response
Sterling Gentran:Server displays this dialog box.

 (Contd)
Step Action
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4 Do you want to continue?

◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, Sterling Gentran:Server displays the Unlock 
<filename> File Status dialog box.

5 Do you want to print the status report?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Copy a Translation Object to the Host User 
Directory

Introduction After you compile a new map to create translation object, you can copy the 
translation object to the Host user directory for testing with the translator.

Copying a
translation

object to the
host user
directory

Use this procedure to copy a translation object to the Host user directory.

Step Action

1 Open the Sterling Gentran:Server Main Window.

2 Select Copy .TBL/.TPL file to User Directory....

System Response
Sterling Gentran:Server displays a dialog box for you to select the 
file you want to copy.

3 Select the translation object (TPL file) and click Open.

System Response
Sterling Gentran:Server copies the file to the User Directory on the 
Host.
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How to Check In Maps and Translation Objects

Introduction This topic explains how to check in maps and the translation objects (TPL 
files)associated with them.

What happens
when you check

in a file

When you check in a file, Sterling Gentran:Server transfers a copy of the file from 
the working directory on your PC to the user directory on the Host. You can 
choose whether to keep or remove the copy of the file that is on your PC.

After the file has been transferred, Sterling Gentran:Server:
◗ copies the file from the user directory to the master directory
◗ removes the copy from the user directory
◗ unlocks the master file so that others can access it

Maps The procedure for checking in maps differs from that for checking in other files, 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.
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Checking in
maps and

translation
objects

Use this procedure to replace a map in the master directory with a modified 
working map.

Step Action

1 Click Check In from the Main File menu and select Map as the 
type of file to check in.

System Response
The system displays the Select Map Files to Check in dialog box. 

Note
The list on the left shows only the maps that are in your working 
directory.

WARNING
For example, if you are creating a new map in the 
Application Integration system using the XXX.vmp as a 
guide, then save the new map using the file name 
XXY.map or XXXa.map.
Sterling Gentran:Server does not recognize map 
extensions. When you check in a working map to the 
master directory, it overwrites any existing map file that 
has the same file name, regardless of the extension.
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2 Use this table to determine your next step.

IF you want to… THEN…

Check in a map Select the map you want to 
check in from the list and click 
Add.

Repeat this step for each 
additional map you want to 
check in.

Check in all the available maps Click Add All.

3 Click Next.

System Response
Sterling Gentran:Server displays the Select TBL/TPL Files to 
Check In dialog box.

4 Do you want to check in the translation objects (compiled maps) 
associated with the maps you selected?

◗ If YES, select the check box next to the name of the translation 
object.

◗ If NO, clear the check box from the translation objects that you 
do not want to check in.

 (Contd)
Step Action
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5 Click Finish.

System Response
The system moves the selected files from the working directory on 
the client to the user directory on the Host. After the files have been 
transferred successfully, the system moves them from the user 
directory to the master directory and unlocks the master files.

 (Contd)
Step Action
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How to Check In File Definitions 

Introduction When you are satisfied with a file definition file, you check in the working file. 
When you check in a working file, the system copies the file from the working 
directory to the master directory, replacing the original file. The working file 
becomes the new file definition. You can choose to leave a copy of the file in the 
working directory or remove it.

Checking in a file
definition

Use this procedure to check in a file definition file.

Step Action

1 Select Check In from the Sterling Gentran:Server Main File menu 
and click either File Definition File

System Response
Sterling Gentran:Server displays the Select File Definition File 
<filename> to Check in dialog box.
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single file definition file Select the file definition  file you 
want to check in from the list in 
the left pane and click Add.

Repeat this step for each 
additional file you want to check 
in.

all the available file definition  
files

Click Add All.

3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
Sterling Gentran:Server displays the Check-in File Definition File 
Status dialog box.

 (Contd)
Step Action
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4 Do you want to print the information displayed in the Check-in File 
Definition File Status report?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Client Descriptions

Tracking Table
This table is provided to help you maintain the locations of your clients. Use the 
table to record client serial numbers, IP addresses, and descriptions of the client 
PCs in your organization. The first line contains a sample entry.

Client Serial # IP Address Description

12345678 000.00.0.00 PC in John Smith’s office
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Client Serial # IP Address Description
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Installing Sterling Gentran:Server
Extension

These instructions explain how to install IBM® Sterling Gentran:Server® 
Extension for SAP R/3 onto your Sterling Gentran:Server computer. 

Verifying System Requirements

Operating
systems

This table lists the operating systems required on the supported Sterling 
Gentran:Server platforms. 

Patches
Hewlett-Packard provides service patches to their operating system. For the most 
recent information, check the Hewlett-Packard Web Site, or contact your Hewlett-
Packard representative. 

Hardware Platform Operating System and Version

HP 9000 HP-UX 11.31 

IBM RS6000 A minimum or AIX 5.3 

SUN Solaris 10 
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Pre-installation
checklist

The following pre-installation checklist details items you need to install the 
extension software. Verify that you have met the requirements and check each 
box as you complete each item.

Checkbox Pre-Installation Checklist

Verify that IBM® Sterling Gentran:Server® for UNIX version 6.2 is 
installed on this UNIX system.

Identify the name of the directory containing the Sterling 
Gentran:Server software. 

Verify that you have the correct media containing the extension 
software.

Identify the device name of the drive you are using to install the 
media.

Verify that SAP system R/3 is installed.

Verify that the SAP-supplied Remote Call Function (RFC) 
programs rfcexec and startrfc are located on your UNIX system. 
These are included on the SAP distribution CD RFCSDK.

Verify that SAP TCP/IP services entries are defined in the 
/etc/services file on your UNIX system.
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How to Upgrade from Prior Versions

Introduction If you are upgrading from version 5.2.1, 5.3, or 5.4 to version 6.2 of Sterling 
Gentran:Server, and Sterling Gentran:Server Extension, complete this procedure.

Procedure Use this procedure to upgrade to version 6.2.

Step Action

1 Back up your 5.2.1, 5.3, or 5.4 software and data.

2 If you have not already done so, install IBM® Sterling 
Gentran:Server® for UNIX 6.2.

3 Install the 6.2 SAP Configuration client software

4 Load the 6.2 SAP host installation files.

5 If you have not already done so, convert your data from your 
current version to version 6.2.

Reference
See the IBM® Sterling Gentran:Server® for UNIX Upgrade and 
Data Conversion Guide for instructions.

6 Copy the mysql tables from your current installation to your 6.2 
installation as follows:
◗ Go to the SAP Extension installation directory.
◗ Run this command:

cp_mysql.sh

7 At this prompt, "Is this the correct setting for OLD_EDI_ROOT," 
type n.

8 At this prompt, "Enter the value for OLD_EDI_ROOT (Server 5.x)," 
type the EDI_ROOT value for the 5.2.1/5.3/5.4 installation.

9 At this prompt, "Is this the correct setting for NEW_EDI_ROOT 
(Server 6.2)," type y to confirm the value or n to specify a new 
value.
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How to Install the Configuration Client

Introduction The SAP Configuration client is used to define and maintain the routing 
information between Sterling Gentran:Server and the SAP system.

Before you begin Before you begin loading the SAP Configuration client software, ensure that 
Sterling Gentran:Server is installed onto the host and client computers.

Procedure Use this procedure to install the SAP Configuration client onto your Sterling 
Gentran:Server client computer.

Step Action

1 Insert the Sterling Gentran:Server Extension CD into the CD-ROM 
drive on the client computer.

2 Select Run from the Start menu. In the Run dialog box, enter the 
following command where “e” represents the letter assigned to the 
CD-ROM drive, then click OK:
e:\Client\setup

System Response
Setup displays the Welcome dialog box.

3 Click Next to continue.

System Response
Setup displays the Choose Destination Location dialog box.

4 Does IBM® Sterling Gentran:Server® for UNIX 6.2 exist in the 
destination folder listed?
◗ If YES, click Next to accept the destination folder for your SAP 

Extension.
◗ If NO, browse to the folder that contains IBM® Sterling 

Gentran:Server® for UNIX 6.2

Note
You must install the SAP client software into the folder that has 
your Sterling Gentran:Server client software.

System Response
Setup displays the Sterling Gentran:Server Extension Setup dialog 
box, which displays the current settings for installation.
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5 Click Next to accept the installation settings.

System Response
Setup displays the SAP Client Installation dialog box.

6 Click Continue to install the client software.

System Response
Setup installs the software and then displays the SAP Client 
Installation Complete dialog box.

7 Do you want to restart your computer now?
◗ If YES, select the Yes, I want to restart my computer now 

option.

Recommendation
You should restart your computer.

◗ If NO, select the No, I will restart my computer later option.

8 Click Finish to complete the installation of the SAP Configuration 
client.

 (Contd)
Step Action
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How to Load the SAP Extension Host Installation Files

Introduction During installation you must run a transfer program to copy compressed software 
files from a compact disc into the proper directories on the UNIX host computer. 
This topic explains how to use the transfer program to read the installation files 
from a compact disc in a Windows client computer into the temporary directory on 
the UNIX host.

Before you begin Before you begin loading the SAP 6.2 extension installation files onto the UNIX 
host computer, you must have created a UNIX login to install and own the Sterling 
Gentran:Server installation.

Copying
installation files

from the
compact disc

Use this procedure to copy the installation files to the UNIX host from a CD-ROM 
drive on a Windows client computer.

Comment
The connection between the Windows client and the UNIX host must support 
TCP/IP. 

The Windows client computer must be able to connect to the UNIX host.

Step Action

1 Insert the Sterling Gentran:Server Extension installation CD into a 
CD-ROM drive in a Windows client that is connected to the UNIX 
host. 

2 From the Start menu, point to Programs and select MS-DOS 
Prompt.

System Response
Windows opens an MS-DOS Prompt window.

3 In the MS-DOS window, change directories to the CD-ROM drive 
on the Windows computer.

4 In the MS-DOS window, change directories to the host operating 
system platform.

Example:
cd Host\HP
cd Host\IBM
cd Host\SUN
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5 Enter the following command to copy the SAP extension 
installation files to the host.
ftpprod <host> <path> <user> <password>

Where
◗ <host> is the system name for the UNIX host
◗ <path> is the path on the UNIX host to temporarily transfer the 

installation files to 

Note 
This path will be created for you, if permissions allow.

◗ <user> is the user login for the EDI user you created
◗ <password> is the user password for the EDI user

System Response
The ftpprod script displays messages about the transfer process. 
When the process is complete, the script displays “Files 
transferred.”

6 Close the DOS window.

7 Continue with the next topic, How to Install the SAP Extension onto 
the Host.

 (Contd)
Step Action
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How to Install the SAP Extension onto the Host

Introduction To install the SAP extension, you run the sh ./sapsetup.sh script to install the 
software into the appropriate directories on the UNIX host. 

Before you begin You must first install the core Sterling Gentran:Server software before you can 
install the SAP extension. 

Installing on the
UNIX host
computer

Use this procedure to install the SAP extension onto the UNIX host computer.

Step Action

1 On the UNIX host computer, make sure the copied SAP Installation 
files are in the temporary directory you specified earlier.

2 Change directories to the temporary directory from the previous 
procedure and enter the following command to unpack the 
installation files and start the installation process.
sh ./sapsetup.sh

System Response
The installation program displays status messages about the 
ongoing process of the installation. The installation program will 
give you a message that the process completed successfully.

Note
The installation program may prompt you to enter values for 
environmental variables that are not set up. When prompted, type 
in the missing value and press Enter. Confirm the value you 
entered by typing y. If you want to specify another value, type n. 
Press Enter again. The installation program continues.
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How to Convert Version 5.x Flows to the 6.2 Format

Introduction When you install the SAP extension software, modifications are made to the 
flowmgr.exe, which gives you the option of opening your existing 5.x flows and 
saving them in the 6.2 format. This topic explains how to convert your existing 5.x 
flows to the 6.2 format.

Why convert 5.x
flows

Converting 5.x flows to the 6.2 format enables you to use the new functionality for 
flows in IBM® Sterling Gentran:Server® for UNIX version 6.2. Also, in converting 
the 5.x flows, you are ensured that the flows contain core product script changes.

NOTE
Converting 5.x flows to the 6.2 format is an option. These flows will 
continue to work as is in Sterling Gentran:Server if you decide not to 
convert.

When to convert
a 5.x flow

Convert an existing 5.x flow to the 6.2 format the first time you open it in the 
Process Control Manager.

Procedure Use the following procedure to convert existing 5.x flow to the 6.2 formats.

Step Action

1 Edit the flow in the Process Control Manager.

System Response
The system displays the prompt: “You have chosen to edit a flow 
from previous version. Do you want to convert the flow to the 
current version? If you click Yes, existing scripts are converted to 
the current version using default values for the new option. If you 
click No, existing scripts remain unchanged.”
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2 Do you want to convert the flow to the current version?
◗ If YES, click Yes and continue with next step.

System Response
Sterling Gentran:Server reads the existing 5.x fields and 
populates the 6.2 specific fields with default values.

Sterling Gentran:Server displays the Flow Edit dialog 
box.

◗ If NO, click No and continue with Step 5.

System Response
Sterling Gentran:Server displays the Flow Edit dialog 
box.

3 Do you want to modify the default values for the new fields?
◗ If YES, select the tab that contains the field you want to modify 

and then modify the field; continue with the next step.
◗ If NO, GO TO Step 6.

4 Do you want to modify another field under a different tab?
◗ If YES, return to Step 3.
◗ If NO, GO TO Step 6.

5 Do you want to view the 5.x flow values?
◗ If YES, click each tab you want to view and then GO TO Step 7.
◗ If NO, GO TO Step 7.

6 Click OK to save your changes.

7 Click Cancel to close the Flow Edit dialog box.

Step Action
Getting Started Guide – May 2011



 Getting Started Guide - 2011

Upgrading from a previous version of SAP Extension

Upgrading from a previous version of SAP Extension

sapcnvrt. The script sapcnvrt.sh can be used to migrate data configuration files from 
previous versions of the Sterling Gentran:Server SAP Extension.  The script 
requires the installation directories location of the current and previous versions of 
the Sterling Gentran:Server for Unix, and a path to the previous versions ODBC 
ini file.  There is an optional parameter to indicate if duplicate records can be 
overwritten.  This script should be run from the $EDI_ROOT directory of the new 
Sterling Gentran:Server for Unix installation.  As a result of running the script, the 
sap_intp, sap_outtp, and sap_route ISAM files will be populated with the records 
from the previous Sterling Gentran:Server SAP Extension corresponding tables. 

Command Usage Usage:

    sapcnvrt.sh <old_install_dir> <old_odbcini>  <new_install_dir> [-o|-no]

Where,

◗ old_install_dir is the path to old environment's root install directory (e.g. /old/
edi/root)

◗ old_odbc_ini is the path to old environment's ODBC ini file (e.g. /old/edi/root/
odbc/odbc.ini)

◗ new_install_dir is the path to new environment's root install directory (e.g. /
new/edi/root)

◗ -o overwrites duplicate records
◗ -no do NOT overwrite duplicate records (default)

 
 
 
                                     Note: The database in the source SAP Extension must be started prior to running 
                                     sapcnvt. Otherwise, the program will not be able to export from the database.  
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Glossary

Glossary
Adobe Reader An Adobe program designed to read and display Portable Document Format 
(PDF) documents. Older versions were known as Acrobat Reader.

application The business software generating the business information that you are sending 
or receiving electronically.

check in The act of returning a copy of a file from your working directory to the master 
directory, making it available to other users.

check out The act of copying a file from the master directory to your working directory, 
making the file unavailable to other users.

client The computer in a client/server network that acts as the interface between the 
user and the server.

client/server A computer network architecture in which data is stored and processing is 
performed on the server, which users access through the interface provided on 
the client. 

default A value that is automatically assigned.

DNS Domain Name Services.
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EDI Electronic Data Interchange.

Application-to-application transfer of key business transaction information in a 
standard or XML format via a computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of transaction data.

GENCOD The GENCOD standard was developed by the French National Numbering 
Organization GENCOD-EAN France. The GENCOD standard is used mainly in 
France within the retail market by some major retailers and manufacturers.

HIPAA Health Insurance Portability and Accounting Act.

lock The act of making a file unavailable to other users. A file is locked once it is 
checked out.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI document and the data fields 
in your application,

◗ The elements in an XML document and the data fields in your application, EDI 
standard document, or in another XML document,

◗ The segments and elements of two different standards, or
◗ The records and fields of two different applications.

master directory The directory on a PC or on a server that stores your master files.

master file The version of a file that Sterling Gentran:Server uses to process data. 

MDAC Microsoft Data Access Components.
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NCPDP National Council of Prescription Drug Programs.

PCM Process Control Manager.

server The computer in a client/server network that performs the major system security, 
data storage, and computing tasks.

standard format A format intelligible to computerized data management systems.

temporary file A file on the client that Sterling Gentran:Server uses during editing and compiling.

trading partner The company, division, or group with which you are exchanging business data 
electronically.

Trading
Partnership

An arrangement to exchange information in a specific document type with a 
specific trading partner and using a particular standard version.

unlock The act of making a file available to other users. A file is unlocked once it is 
checked in.

user directory The directory on the server that temporarily holds the files being transferred from 
a client working directory to the master directory on the server.

VAN Value Added Network.

VDA Verband der Deutschen Automobilindustrie. A German group responsible for a 
range of different standards in the automobile industry.
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working file
directory

The directory created on the client to hold the files that a user is editing.

XML Extensible Markup Language. Describes a class of data objects called XML 
documents, and partially describes the behavior or computer programs which 
process them.
Getting Started Guide - May 2011



-1N - 1
CHAPTER

N

Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send inquiries, 
in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
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Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express 
or implied warranties in certain transactions, therefore, this statement may not 
apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements and/
or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer Agreement, 
IBM International Program License Agreement or any equivalent agreement 
between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments may 
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vary significantly. Some measurements may have been made on development-
level systems and there is no guarantee that these measurements will be the 
same on generally available systems. Furthermore, some measurements may 
have been estimated through extrapolation. Actual results may vary. Users of this 
document should verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to 
change before the products described become available. This information 
contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include the names of 
individuals, companies, brands, and products. All of these names are ficticious 
and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to 
IBM, for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating 
platform for which the sample programs are written. These examples have not 
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or 
imply reliability, serviceability, or function of these programs. The sample 
programs are provided "AS IS", without warranty of any kind. IBM shall not be 
liable for any damages arising out of your use of the sample programs. 

Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows:

© IBM 2016. Portions of this code are derived from IBM Corp. Sample Programs. 

© Copyright IBM Corp. 2016.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.

Trademarks IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
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worldwide. Other product and service names might be trademarks of IBM or other 
companies. A current list of IBM trademarks is available on the Web at “Copyright 
and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States, 
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and 
Telecommunications Agency which is now part of the Office of Government 
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, 
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or 
registered trademarks of Intel Corporation or its subsidiaries in the United States 
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the 
Office of Government Commerce, and is registered in the U.S. Patent and 
Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Java and all Java-based trademarks and logos are trademarks or registered 
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in 
the United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are 
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®, 
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®, 
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling 
Commerce™, Sterling Information Broker®, and Sterling Integrator® are 
trademarks or registered trademarks of Sterling Commerce, Inc., an IBM 
Company.

Other company, product, and service names may be trademarks or service marks 
of others.

http://www.ibm.com/legal/us/en/copytrade.shtml
http://www.ibm.com/legal/us/en/copytrade.shtml
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